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Пояснительная записка 
Методические указания по выполнению практических заданий разработаны в соответствии 

с рабочей программой и могут быть использованы как для проведения практических занятий 

(основных и факультативных), так и для индивидуального усовершенствования имеющихся 

навыков работы с компьютерными программными продуктами. 

Представленные, в данных методических указаниях, практические задания направлены на 

формирование знаний и умений по дисциплине, а так же общих и профессиональных 

компетенций: 

ОК 1. Понимать сущность и социальную значимость своей будущей профессии, проявлять к 

ней устойчивый интерес. 

ОК 2. Организовывать собственную деятельность, выбирать типовые методы и способы 

выполнения профессиональных задач, оценивать их эффективность и качество. 

ОК 3. Принимать решения в стандартных и нестандартных ситуациях и нести за них 

ответственность. 

ОК 4. Осуществлять поиск и использование информации, необходимой для эффективного 

выполнения профессиональных задач, профессионального и личностного развития. 

ОК 5. Использовать информационно-коммуникационные технологии в профессиональной 

деятельности. 

ОК 6. Работать в коллективе и команде, эффективно общаться с коллегами, руководством, 

потребителями. 

ОК 7. Брать на себя ответственность за работу членов команды (подчиненных), результат 

выполнения заданий. 

ОК 8. Самостоятельно определять задачи профессионального и личностного развития, 

заниматься самообразованием, осознанно планировать повышение квалификации. 

ОК 9. Ориентироваться в условиях частой смены технологий в профессиональной 

деятельности. 

ПК 5.3. Обслуживать оборудование для выработки мясных полуфабрикатов. 

В результате изучения дисциплины ОП.05 «Информационные технологии в 

профессиональной деятельности» студент должен: 

уметь: 

- использовать технологии сбора, размещения, хранения, накопления, преобразования и 

передачи данных в профессионально ориентированных системах; 

- использовать в профессиональной деятельности различные виды программного 

обеспечения, в том числе специального; 

- применять компьютерные и  телекоммуникационные средства. 

знать: 



- основные понятия автоматизированной обработки информации; 

- общий состав и структуру персональных компьютеров и вычислительных систем; 

- состав, функции и возможности использования информационных и 

телекоммуникационных технологий в профессиональной деятельности; 

- методы и средства сбора, обработки, хранения, передачи и накопления информации; 

- базовые системные программные продукты и пакеты прикладных программ в области 

профессиональной деятельности; 

- основные методы и приёмы обеспечения информационной безопасности. 

Методические указания по выполнению практических заданий нацелены на освоение 

навыков практического применения знаний по информатике студентов, обучающихся по 

профессии 19.01.12  «Переработчик скота и мяса». 

Методические указания по выполнению практических занятий содержат практические 

(обучающие и контролирующие) задания по применению приложений Microsoft Office, программ 

работы с системами распознавания информации, графических редакторов, а также 

профессиональной справочно-правовой системы КонсультантПлюс. 

 

Общие указания по выполнению практических работ  

Практические работы выполняются после изучения теоретического материала 

соответствующих тем. 

Перед началом выполнения работы внимательно, вдумчиво прочитайте задание.  

После этого приступайте к выполнению практического задания в порядке, изложенном в 

тексте работы.  

Выполнение каждой  практической работы состоит из следующих этапов:  

- самостоятельная подготовка студентов; 

- выполнение практической работы; 

- проверка результатов работы преподавателем. 

 

Критерии оценки 

Оценка «5» выставляется за правильно выполненное задание в полном объеме за 

отведенное время. 

Оценка «4 » выставляется  либо за правильно выполненное задание в полном объеме, но с 

превышением установленного времени, либо за выполнение задания с небольшими ошибками за 

отведенное время. 

Оценка «3 » выставляется при наличии существенных ошибок в выполненном задании. 

Оценка «2 » выставляется при отсутствии выполненного задания. 

  



Инструкция по охране труда при проведении практических работ на 
персональных компьютерах. 

 

В кабинете информатики находится дорогостоящая и требующая аккуратного обращения 

аппаратура.  

Поэтому необходимо:  

- бережно обращаться с техникой; 

- спокойно, не торопясь входить в кабинет. 

 

Строго воспрещается: 

- трогать разъёмы соединительных кабелей; 

- прикасаться к проводам и устройствам заземления; 

- прикасаться к тыльной стороне монитора; 

- включать и отключать аппаратуру без указания преподавателя; 

- вставлять посторонние предметы в дисководы, CD ROM; 

- класть книги и тетради на монитор и клавиатуру; 

- не двигать и не ударять включенные монитор и системный блок; 

- работать во влажной одежде и влажными руками; 

- есть и пить на рабочем месте; 

- приходить в верхней  одежде или приносить её с собой. 

 

Перед началом работы: 

- убедитесь в отсутствии видимых повреждений рабочего места; 

- сядьте так, чтобы линия взора приходилась в центр экрана, чтобы не наклоняясь 

пользоваться клавиатурой и воспринимать передаваемую на экран монитора информацию; 

- разместите на столе тетрадь, учебное пособие, так, чтобы они не мешали работе на 

компьютере; 

- внимательно слушайте объяснение учителя и старайтесь понять цель и 

последовательность действий. 

 

Во время работы: 

- плавно нажимайте на клавиши, не допуская резких ударов; 

- не пользуйтесь клавиатурой, если не включён компьютер; 

- при появлении необычного звука или самопроизвольного отключения аппаратуры 

немедленно прекратите работу и сообщите об этом преподавателю; 

- никогда не пытайтесь самостоятельно устранять неисправности в работе аппаратуры; 



- не вставайте со своих мест, когда в кабинет входят посетители. 

 

По окончании работы нужно: 

- привести в порядок рабочее место; 

- выключить компьютер. 

 

ВЫ ОТВЕЧАЕТЕ ЗА СОСТОЯНИЕ РАБОЧЕГО МЕСТА И СОХРАННОСТЬ 

РАЗМЕЩЁННОГО НА НЁМ ОБОРУДОВАНИЯ! 

 

  



Практическая работа 

MSWORD. Создание и сохранение документа, форматирование. 
Параметры страницы, колонтитулы 

Цель работы: научиться устанавливать параметры страницы, 

редактировать и форматировать текстовый документ. 

 

Теоретический материал 

 

Создание колонтитула Колонтитул - заголовочные данные, помещаемые над текстом 

страницы (иногда сбоку, внизу) книги, журнала, газеты. 

Команда Вставка – Верхний или Нижний колонтитул 

 
Параметры страницы Команда Разметка страницы – Параметры страницы 

Изменение шрифта 
Кнопка на панели инструментов «Шрифт» 

Изменение размера шрифта 
Кнопка на панели инструментов «Шрифт» 

Изменение начертания 

шрифта 

Кнопки на панели инструментов «Шрифт»: полужирный, курсив, 

подчеркнутый  

Выравнивание текста Кнопки на панели инструментов «Шрифт»: по левому краю, по 

центру, по правому  

Изменение цвета текста 
Кнопки на панели инструментов «Шрифт»: 

Отступ 1. Команда Главная - Абзац (указать количество см отступа) 

2. Использовать клавишуTab клавиатуры 

3. Линейка форматирования 

Отступ первой строки 

Отступ всех строк кроме  первой строки 

 

Отступ всего выделенного фрагмента 

Порядок работы: 

  

Задание 1. 

Установить параметры станицы: верхнее, нижнее поле – 2 см, левое – 3 см, правое – 1,5 

см. 

Набрать текст с учетом форматирования (размер шрифта - 14 пунктов, шрифт Times 

New Roman). 

 

Сколько битов может быть в байте? 

Название «байт» (слово byte представляет собой сокращение словосочетания 

BinarYTErm — «двоичный терм») было впервые использовано в 1956 году В. Бухгольцем при 

проектировании первого суперкомпьютера IBM 7030 Stretch. 

В 1950-х и 1960-х годах не было единого стандарта относительно количества битов в 

байте. В разных компьютерных системах байт содержал от 6 до 9 битов. 

Лишь с начала 1970-х годов в большинстве архитектур стали использовать байт 

размером 8 битов, и постепенно такое соотношение стало стандартным. 

https://ru.wikipedia.org/wiki/1956_%D0%B3%D0%BE%D0%B4
https://ru.wikipedia.org/wiki/1956_%D0%B3%D0%BE%D0%B4
https://ru.wikipedia.org/wiki/%D0%A1%D1%83%D0%BF%D0%B5%D1%80%D0%BA%D0%BE%D0%BC%D0%BF%D1%8C%D1%8E%D1%82%D0%B5%D1%80
https://ru.wikipedia.org/wiki/%D0%A1%D1%83%D0%BF%D0%B5%D1%80%D0%BA%D0%BE%D0%BC%D0%BF%D1%8C%D1%8E%D1%82%D0%B5%D1%80


Для устранения двусмысленности в компьютерной литературе иногда для точного 

обозначения последовательности 8 битов вместо термина «байт» используют термин 

«октет». 

  

Задание 2. 

Наберите текст. Используйте 16 размер шрифта. Заголовок - шрифт Arial. 

Вставьте строку выше заголовка «Информация к размышлению» (шрифт Курсив, 

выравнивание по правому краю). Скопируйте текст 4 раза. Выровняйте: первый текст - по 

ширине, второй - по левому краю, третий - по правому краю, четвертый – по центру. 

 

Компьютер в нашем мире 

Сейчас, наверно трудно найти человека, который хотя бы раз в жизни не встретился бы 

с компьютером. Компьютеры приходят к нам в дом, помогают облегчить работу человека. 

Различные программы могут обучать и развлекать. 

С помощью глобальной сети Internet люди могут общаться, находить нужную 

информацию, даже если она находится «на другом конце света». 

 

Задание 3. 

Набрать текст по образцу. 

 

Вчитайтесь в стихотворение М.Ю. Лермонтова «Лирик»: 

 

Хотел бы в единое слово 

Я слить свою грусть и печаль,  

И бросить то слово на ветер, 

Чтоб ветер унес его в даль 

(М.Ю.Лермонтов) 

Как велик поэт! Всего в нескольких словах, объединенных рифмой, он сумел 

выразить силу чувств, стремительность мысли, благородство русского языка. Легкость слога 

мы встречаем во многих, если не сказать во всех стихотворениях Михаила Юрьевича. 

 

Ночевала тучка золотая  

На груди утеса-великана. 

 

 

 

  

Зада ние 4. 

Тучки небесные –  

Вечные странники! 

Этот текст содержит 325 знаков с пробелами. Засеките время и наберите текст. 

Определите скорость печати (знаков в минуту). Вставьте Дату с помощью команды  Вставка 

- Дата и время. 

 

Директору колледжа 

Веселову С.В. 

студента 100 группы 

Глебова Алексея 

Объяснительная записка 

 

Я, Глебов Алексей, опоздал сегодня на урок информатики, потому, что всю ночь сидел 

в интернете и активно чатился. Подхватил там несколько троянов и червей, вызвал доктора 

Касперского, с трудом вылечился. Больше не буду. 

 

19 сентября 2015 г. 

  



Задание 5. 

Наберите данный текст и создайте верхний колонтитул «Династия Романовых» и 

нижний   колонтитул – дата создания. 

 
Император Годы жизни Царствование 

Александр I 1777-1825 1801-1825 

Николай I 1796-1855 1825-1855 

Александр II 1818-1881 1855-1881 

Александр III 1845-1894 1881-1894 

Николай II 1868-1918 1894-1917 

 

Контрольные вопросы: 

Основное назначение текстового редактора? 

Что такое редактирование текстового документа 

Что такое форматирование текстового документа? 

Что такое колонтитул, назовите основные виды колонтитулов? 

  



 

Практическая работа 

MSWORD. Математические формулы. Шаблоны. Работа с 
многостраничными документами 

Цель работы: научиться создавать и редактировать формулы с помощью  встроенного 

редактора формул в программе MS Word. 

Теоретический материал 

Вставка формулы Команда Вставка - Уравнение 

Редактирование 

формулы 

Для редактирования созданной формулы достаточно щелкнуть 

на ней и загрузится редактор формул. Чтобы удалить формулу, 

необходимо нажать клавишу Delete на клавиатуре. 

Порядок работы: 

 Задание 1. 

Набрать математические выражения вместе с текстом по образцу. 

 

 

Теоретический материал 



 

Создание 

оглавления 

1. Создать заголовки 1 уровня или 2 уровня для названий 

пунктов содержания с помощью команды Главная – 

Заголовок 1 уровня. 

 
2. Создать оглавление с помощью команды Ссылки – Оглавление. 

 
Обновление 

оглавления 

После различных изменений в документе можно автоматически 

обновлять 

оглавление, для этого необходимо щелкнуть правой кнопкой мыши по 

оглавлению и выбрать команду Обновить оглавление. 

Нумерация 

страниц 
Команда Вставка – Номер страницы. 

Можно установить особый колонтитул для первой страницы, в 

результате номер первой (титульной страницы виден не будет). 

Порядок работы: 

Задание 2. 

 Откройте файл Реферат.docx. 

 Оформите титульную страницу по образцу. 

 Пронумеруйте страницы документа. 

 Оформите оглавление реферата. 

 Отформатируйте документ: 

шрифт – Times New Roman, 

размер шрифта – 14 пт, заголовки – 16 пт, полужирное начертание, 

выравнивание – по ширине, заголовки по центру. 



 

 

 

Содержание: 

1. Ручной период докомпьютерной эпохи 

2. Механический этап 

3. Электромеханический этап 

4. Поколения современных ЭВМ 

4.1.I поколение 

4.2.II поколение 

4.3.III поколение 

4.4.IV поколение 

4.5.V поколение 

 Список литературы 

Контрольные вопросы: 

1. Для чего необходим редактор формул? 

2. Как редактировать формулы в текстовом редакторе?  

Государственное бюджетное профессиональное 

образовательно учреждение «Кунгурский 

сельскохозяйственный колледж» 

 

 

 

 

РЕФЕРАТ 

 

ПО ДИСЦИПЛИНЕ «ИНФОРМАЦИОННЫЕ ТЕХНОЛОГИИ В 

ПРОФЕССИОНАЛЬНОЙ ДЕЯТЕЛЬНОСТИ» 

ПО ТЕМЕ «ИСТОРИЯ РАЗВИТИЯ ВЫЧИСЛИТЕЛЬНОЙ 

ТЕХНИКИ» 

 

 

 

Выполнил 

студент 

группы  ФИО 

Проверил преподаватель 

Завьялова Н.Ю. 

 

 

 

2020 



 

Практическая работа 

MSWORD. Вставка графических объектов (рисунки, символы, картинки, 
автофигуры, объекты WORDART), таблиц, графиков и диаграмм 

 

Цель работы: научиться создавать и редактировать графические объекты в программе 
MS Word. Научиться создавать и редактировать таблицы. 

 

Теоретический материал 

 

Вставка рисунка 1. Команда Вставка - Рисунок 

2. Скопировать изображение в буфер обмена, а затем добавить его в 

Word: сочетание клавиш ctrl + С и ctrl + V. 

Редактирование 

рисунка 

Щелкнуть по рисунку мышью, появится панель «Работа с 

изображением» 

Вставка объекта 

WordArt 
Команда Вставка - WordArt 

Вставка основных 

автофигур 

 

 

Команда Вставка - Фигуры 

 

Вставка таблицы 1. Команда Вставка – Таблица вставить таблицу (указать в 

открывшемся окне необходимое число столбцов и строк 

таблицы)/нарисовать таблицу (нарисовать таблицу карандашом) 

2. Значок  на  панели  инструментов:      позволяет добавить таблицу 

путем выбора необходимого количества строк и столбцов. 

Границы таблицы Изменить границы можно используя значок на панели инструментов 
 

 
Разбиение и 

объединение ячеек 

Выделить необходимые ячейки, нажать правую кнопку мыши и выбрать 

команду Объединить ячейки или Разбить ячейки. 

 

Порядок работы: 
 Задание 1. 

Оформите следующий текст и рисунок по образцу. 

У природы нет плохой погоды, 

 

 
Всякая погода – благодать. 

 

 Задание 2. 

Дождь и снег, любое время года 

Надо благодарно принимать. 

дождь ясно 
облачно 
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A1 

C 

A 
B 

 

D 

Применяя панель рисования текстового процессора MS Word, изобразите 
предложенный чертеж.  

 

 

 

 
 

Задание 3. 

Постройте чертеж. 

 

 

 

 

 

 

 

 

 

 

 

 

Задание 4. 

Оформите таблицу по образцу. В таблице 1 необходимо использовать нумерацию строк. 

Таблица 1 – Сотрудники фирмы 

 

 

 

 

 

 Задание 5. 

Оформите таблицу по образцу. В таблице 2 необходимо использовать нумерацию  

 

  

 

 

 

 
№ п/п 

 
Фамилия и инициалы студента 

Дата занятия 

февраль 

1 2 3 5 6 7 8 9 10 11 

1 Андронов А.А. + + + + н н + + + + 

2 Каварма Ю.В. + + + + + + + + + + 

3 Кузьменко В.М. + + н н + + + + + + 

4 Харапов В.А. + + + + + н н н н н 

5 Иванов С.В. + + + + + + + + + + 

6 Грачев Б.П. + + + + + + + н н + 

10 ø 

35 

70 

5
0

 

3
0

 

№ Фамилия Имя Отчество Дата 

рождения 
Телефон Должность Стаж 

1 Иванова Анна Петровна 23.12.1963 141585 менеджер 12 

2 Смирнов Иван Сергеевич 12.05.1974 786596 консультант 8 

3 Чистяков Виктор Михайлович 07.05.1965 235643 директор 17 

4 Кузнецов Сергей Иванович 24.12.1963 821124 программист 6 

5 Цветкова Мария Андреевна 13.03.1977 265347 бухгалтер 7 

6 Михалкова Елена Дмитриевна 31.01.1975 435496 секретарь 4 

 

 



 

Задание 6. 

Оформите таблицу по образцу. 

Таблица 4 – Программа Outlook Express 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Контрольные вопросы: 
1. Какие графические возможности представляет текстовый редактор MSWord? 

2. Перечислите основные графические фигуры в MSWord? 
3. Как добавить текст надписи к графическому изображению?  

 
OUTLOOK EXPRESS 

ЛЕВАЯ ЧАСТЬ ОКНА ПРАВАЯ ЧАСТЬ ОКНА 

ПАПКИ:  

 

 

 

 

СПИСОК СООБЩЕНИЙ, 

ХРАНЯЩИЙСЯ В 

ВЫДЕЛЕННОЙ ПАПКЕ 

 

ВХОДЯЩИЕ 

Содержит получаемые адресатом 
письма 

 

ИСХОДЯЩИЕ 

Содержит отправляемые адресатом 

письмас момента их создания и до 

момента их доставки с локального 

компьютера пользователя на почтовый 

сервер провайдера 

 

ОТПРАВЛЕННЫЕ 
Содержит все письма, доставленные на 
почтовый сервер 

 

УДАЛЕННЫЕ 

 

Содержит удаленные письма 

 

ЧЕРНОВИКИ 

 

Содержит заготовки писем 

КОНТАКТЫ:  
СОДЕРЖАНИЕ 

ВЫДЕЛЕННОГО 

СООБЩЕНИЯ 

 

Предоставляют доступ к информации, 

хранящейся в Адресной книге 

(адреса электронной почты, телефоны, …) 

 



 

Практическая работа 

MSWORD. Колонки. Буквица. Ссылки и сноски. Списки. Надписи в тексте. 
Стили. Вставка даты 

Цель работы: научиться создавать и редактировать списки в программе MS Word. Научиться 

создавать и редактировать колонки в программе MS Word. 

Теоретический материал 
 

Маркированный список 
Выбрать значок на ленте Главная 

Нумерованный список 
Выбрать значок на ленте Главная 

Многоуровневый список 
Выбрать значок на ленте Главная. 

Для перехода на нужный уровень списка выбрать команду 

Главная -Уменьшить отступ или Увеличить  

 

Создание колонок Команда Разметка страницы – Колонки – Другие колонки 

 

Переход на другую 

колонку 

Команда Разметка страницы – Разрывы – Столбец 

Вставка буквицы команда Вставка - Буквица 

 

Порядок работы: 
 Задание 1. 

Набрать предложенный текст и оформить списки. 

 

Пифагор 

Пифагор Самосский (VI в. до н. э.) 

1. древнегреческий философ, 

2. религиозный и политический деятель, 

3. основатель пифагореизма, 

4. математик. 

Пифагору приписывается, например, изучение: 

 свойств целых чисел и пропорций, 

 доказательство теоремы Пифагора. 

 

 Задание 2. 

Набрать предложенный текст и оформить списки. 

 

Программное обеспечение 

1. Системное программное обеспечение. 

 Операционная система. 

 Антивирусные средства. 

2. Прикладное программное обеспечение. 

 Графические редакторы. 

o Растровые графические редакторы. 



 

o Векторные графические редакторы. 

 Текстовые редакторы. 

o Простые текстовые редакторы. 

o Текстовые процессоры. 
 

 Задание 3. 

Набрать предложенный текст и оформить списки. 

1. Структура графической системы. 

1.1. Дисплей. 

1.2. Видеоадаптер. 

1.3. Другие графические устройства. 

2. Методы представления графических изображений. 

2.1. Растровая графика. 

2.2. Векторная графика. 

3. Первые шаги в CorelDraw. 

3.1. Рабочий экран. 

3.2. Работа с объектами (начало). 

4. Цвет. 

4.1. Системы цветов. 

4.2. Цвет в CorelDraw. 

4.2.1. Заливка объектов. 

4.2.2. Закраска контуров. 

5. Работа с объектами в CorelDraw (продолжение). 

5.1. Контурные линии. 

5.2. Вспомогательный режим работы. 

5.3. Кривые. 

6. Работа с файлами. 

6.1. Форматирование графических файлов. 

6.2. Сохранение и загрузка изображений в CorelDraw. 

6.3. Импорт изображений в CorelDraw. 
 

  



 

Н П 

 Задание 4 

Оформить следующий текст по образцу. 

 

 

Страна мечты 

 

аверно, каждый мечтает 

хоть раз в жизни побывать в 

стране Бизе и Равеля, Гюго 

и 

Мопассана, «отца мушкетеров» 

Александра Дюма и удивительного 

мечтателя, писателя- фантаста Жюля 

Верна. 

Франция – одно из крупных 

государств западной Европы. Оно 

раскинулось от суровых скалистых 

берегов Нормандии до теплого лазурного 

берега Средиземного моря. Когда-то всю 

территорию Франции покрывали густые 

леса. Ныне они сохранились главным 

образом в горах. Самые высокие горы 

здесь 

– снежные Альпы. По обширным 

низменностям текут полноводные реки – 

Сена, Рона, Луара, Гаронна. 

Париж 

 

ариж – столица Франции, 

ее сердце, ее мозг, ее 

слава. 

Париж – один из 

красивейших городов мира. Ни один 

город страны не принес Франции такой 

популярности в мире, как Париж. 

Символ Парижа - знаменитая 

Эйфелева башня, построенная в 1889 году 

по проекту инженера 

Эйфеля для Всемирной 

выставки. Высота башни 

319 метров. На третьем 

этаже находится музей 

Эйфеля. 

В начале 

строительства Эйфелевой 

башни       50        известных           

французов, в числе которых 

Дюма, написали петицию протеста против 

этого «железного монстра», который 

испортит весь вид Парижа. В наше время 

Эйфелева башня стала одним из самых 

посещаемых туристами памятником 

города.



 

Практическая работа 

Создание, оформление электронных таблиц MSExcel 

Цель: отработать навыки создания и оформления таблиц в MS Excel. 

Оборудование: задать самостоятельно. 

Программное обеспечение: задать самостоятельно. 

Ход работы: 

Ход работы: 

1. Составьте прайс-лист по образцу: 

 

 

Этапы выполнения задания: 

  Выделите ячейку В1 и введите в нее заголовок таблицы Прайс-лист 

магазина "Канцтовары" 

  В ячейку С2 введите функцию СЕГОДНЯ (Поставьте знак «=», на панели 

инструментов вкладка ФОРМУЛЫ выберите Дата и Время вставить 

функцию СЕГОДНЯ). 

 

  В ячейку В3 введите слова «Курс евро», в С3 – курс евро на сегодняшний 

день - 76. 

  К ячейке С3 примените денежный формат (Главная, Вкладка Число, 



 

Числовой формат, Денежный. (Обозначение можно выбрать произвольное). 

 

 

 В ячейки А5:С5 введите заголовки столбцов таблицы. 

  Выделите их и примените полужирный стиль начертания и более 

крупный шрифт. 

 В ячейки А6:А12 и В6:В12 введите данные. 

  В  ячейку С6 введите  формулу: =  В6*$C$3C$C$33 .  ($C$3 означает,  что  

используется абсолютная ссылка). 

 Выделите ячейку С6 и протяните за маркер заполнения вниз до ячейки С13. 

 Выделите диапазон ячеек С6:С12 и примените к ним денежный формат. 

  Выделите заголовок – ячейки В1:С1 и выполните команду: щелчок 

правой клавишей, Формат Ячеек, вкладка Выравнивание и установите 

переключатель 

«по центру выделения» (Горизонтальное выравнивание), «Переносить по 

словам». Увеличьте шрифт заголовка. 

 

 

 

 

 

 

 

 

 

 

 

 Измените название ЛИСТ1 на Прайс-лист. 



 

2. Рассчитайте ведомость выполнения плана товарооборота 

 

 Заполнение столбца Mi можно выполнить протяжкой маркера. 

  Значения столбцов Vi и Oi вычисляются по формулам: Vi=Fi / Pi; 

Oi=Fi – Pi 

 Переименуйте ЛИСТ 2 в Ведомость. 

 Сохраните таблицу в своей папке под именем Практическая работа 1 

 



  



 

Практическая работа 

Решение расчётных задач в MSExcel  

Цель: отработать навыки составления и тестирования программы на 

компьютере разветвляющихся алгоритмов. 

Оборудование: задать самостоятельно. 

Программное обеспечение: задать самостоятельно. 

Ход работы: 

1. Запустите программу Microsoft Excel. 

2. В ячейку А1 введите текст: "Год основания Колледжа". 

Зафиксируйте данные в ячейке любым известным вам способом. 

3. В ячейку В1 введите число – год основания Колледжа (1940). 

4. В ячейку C1 введите число – текущий год (2015) 

5. Выделите ячейку D1установите знак «=», далее щелкните

 мышкой по ячейке C1, поставьте знак «–» и щелкните по ячейке 

B1, нажмите {Ent e r} .Enter}. 

6. В ячейку А2 введите текст "Мой возраст". 

7. В ячейку B2 введите свой год рождения. 

8. В ячейку С2 введите текущий год. 

9. Введите в ячейку D2 формулу для вычисления Вашего возраста в 

текущем году (= C2- B2). 

10. Выделите ячейку С2. Введите номер следующего года. Обратите 

внимание, перерасчет в ячейке D2 произошел автоматически. 

11. Определите свой возраст в 2025 году. Для этого

 замените год в ячейке С2 на 2025. 

 

 

Выполнить: 
Упражнение 1: Посчитайте, хватит ли вам 550 рублей, чтоб купить все 

продукты, которые вам заказала мама, и хватит ли

 купить чипсы за 30 рублей? 

 

№ Наименование Цена в рублях Количество Стоимость 

1 Хлеб 27 2 =С2*D2D2 

2 Кофе 150 1 =С3*D2D3 

3 Молоко 50 3 =С4*D2D4 



 

4 Пельмени 170 1 =С5*D2D5 

5 Чипсы 30 1 =С6*D2D6 

   Итого =Е2+Е3+Е4+Е5+Е6 

Упражнение 2: Рассчитать ежемесячный платеж за кредит в 150000 ₽,  в з ят ы й н а 3, взятый на 3 

года, под 25% годовых (при расчете всех платежей использовать денежный формат) 

 А В С D E 

1 кредит  Проценты 1 год  Ежемесячный платеж 

2 150000,00 ₽ 
(ячейка А2) 

 =(А2*А5)/100% 
(ячейка С2) 

 =С17/А11 
(ячейка Е2) 

3      

4 % годовые  Выплата за 1 год   

5 25,00% 
(ячейка А5) 

 =А2+С2 
(ячейка С5) 

  

6      

7 Срок выплаты (лет)  Проценты 2 год   

8 3 
(ячейка А8) 

 Самостоятельно (ячейка 

С8) 

  

9      

10 Срок выплаты 
(месяцев) 

 Выплата 2 год   

11 =А8*12 
(ячейка А11) 

 Самостоятельно (ячейка 

С11) 

  

12      

13   Проценты 3 год   

14   Самостоятельно (ячейка 

С13) 

  

15      

16   Выплата 3 год   

17   Самостоятельно (ячейка 

С17) 

  

 

Итоги: 

 

  



 

Практическая работа 

Обработка данных таблиц MSExcel  

Цель: отработать навыки обработки данных таблиц с использованием MS 

Excel. 

Оборудование: задать самостоятельно. 

Программное обеспечение: задать самостоятельно. 

Ход работы: 
Задание №1 

Создайте таблицу в соответствие с образцом, приведенным

 на рисунке. Переименуйте лист 1 под именем «Расчет». 

 

Технология выполнения задания: 
1. Установите курсор-рамку внутри таблицы. 

2. Выполните команду меню Данные - Сортировка. 

 

- Выберите Сортировать по - отдел (Все отделы в таблице 

расположатся по алфавиту). 
Для того чтобы ежедневно распечатывать список товаров, оставшихся в магазине 

(имеющих ненулевой остаток), нужно получить отфильтрованные данные. 

- Установите курсор-рамку внутри таблицы данных. 

- Выполните команду меню Данные - Фильтр 

- Снимите выделение в таблицы. 



 

 

- У каждой ячейки заголовка таблицы появилась кнопка "Стрелка 

вниз", она не выводится на печать, позволяющая задать критерий 

фильтра. Мы хотим оставить все записи с ненулевым остатком. 

- Щелкните по кнопке со стрелкой, появившейся в столбце 

Количество остатка. Раскроется список, по которому будет 

производиться выборка. Снимите галочку с цифры ноль. Нажмите ОК. 

Данные в таблице будут отфильтрованы. 

 

- Вместо полного списка товаров, мы получим список проданных на 

сегодняшний день товаров. 

- Фильтр можно усилить. Если дополнительно выбрать какой-нибудь 

отдел, то можно получить список неподанных товаров по отделу. 

- Для того, чтобы снова увидеть перечень всех непроданных товаров 

по всем отделам, нужно в списке "Отдел" выбрать критерий "Все". 

- Чтобы не запутаться в своих отчетах, вставьте дату, которая будет 

автоматически   меняться    в    соответствии    с    системным    

временем компьютера Формулы – Вставить функцию - Дата и время 

- Сегодня. 

 

- Восстановите исходный вариант таблицы и отмените режим 

фильтрации. Для этого щелкните по кнопке со стрелкой и в 

раскрывшемся списке выберите строку Все, либо выполните команду 



 

Данные - Фильтр – Выделить все. 



 

Практическая работа 

Построение графиков и диаграмм с использованием 

таблиц MSExcel  

Цель: отработать навыки построения графиков и диаграмм в табличных 

процессорах. 

Оборудование: задать самостоятельно. 

Программное обеспечение: задать самостоятельно. 

Ход работы: 

Построить график для формулы 

Выполнение: 

1. Откройте свою практическую работу №5 

 

2. Постройте диаграммы 

- для столбца m (выделить весь столбец, на панели инструментов 

выбрать вкладку 

Вставка – Диаграммы – График – выбрать любой - ОК) 

 

- для всех столбцов: выделить все столбцы, Вставка –

 Диаграммы – Гистограмма – выбрать любую - ОК) 



 

 

- для столбцов h и ω: выделить столбцы, Вставка – Диаграммы – 

Линейчатая – 
выбрать любую - ОК) 

 

- для столбцов  c и m: выделить столбцы, Вставка – 

Диаграммы – Другие – Поверхность - выбрать любую - ОК) 

 

3. Пересохранить работу. 
  



 

Практическая работа 

Создание и заполнение БД в  СУБД MSACCESS 
Цель: отработать навыки работы с системами управления базами данных. 

Оборудование: задать самостоятельно. 

Программное обеспечение: задать самостоятельно. 

Ход работы: 

1. Запустите Microsoft Access 2007. 

2. Нажмите на кнопку .  

3.     Задайте имя новой базы данных «Школа» 

4.     В строке меню выберите вкладку Создание/Таблица. 

5.     Нажмите на кнопку Вид и выберите Конструктор. 

6.     Сохраните таблицу под именем «Преподаватели» 

7.     Введите имена полей и укажите типы и размеры данных, к которым они 

относятся 

Имя поля Тип данных Размер поля Маска ввода 

Код преподавателя Счетчик    

Фамилия Текстовый 15   

Имя Текстовый 15   

Дата рождения Дата/время Длинный формат даты   

Должность Текстовый 10   

Домашний телефон Текстовый  #-##-## 

Зарплата Денежный    

8.     Перейдите в режим таблицы для этого выберите вкладка Режим/ Режим 

таблицы. 

9.     Заполните таблицу 10 строками. 

2.     Создайте новую базу данных «Сотрудники»,  для этого 

       Нажмите на кнопку.  

       Задайте имя новой базы данных «сотрудники» 

3.     Создайте таблицу на основе шаблона «Контакты», для этого 

На вкладке Создание        Шаблоны таблиц    Контакты 

4.     Заполните таблицу согласно образцу. 



 

Номер 

Сотрудника 

Организация Фамилия Имя Отчество Должность Рабочий 

телефон. 

1 Школа № 2 Петров Иван Сергеевич Директор 2-58-06 

2 Школа № 23 Иванов Роман Иванович Зам. директора 5-75-88 

3 Школа № 77 Павлова Алла Сергеевна Гл. Бухгалтер 2-02-78 

4 Гимназия №1 Боярская Ольга Андреевна Бухгалтер 4-44-44 

5 Школа № 76 Сидорова Елена Петровна Директор 5-85-75 

6 Школа № 79 Сенчилов Антон Сергеевич Учитель информатики 9-08-42 

7 Школа № 80 Чернов Олег Олегович Учитель биологии 2-77-85 

8 Школа № 23 Зайцев Петр Викторович Учитель математики 4-75-23 

9 Школа № 14 Андреев Иван Игоревич Учитель химии 4-58-75 

10 Школа № 32 Петрова Ирина Павловна Учитель физики 2-58-09 

  

5.     Сохраните таблицу. 

 



 

Практическая работа 

Работа с данными при помощи запросов. Создание 
отчетов в БД при помощи СУБД MSACCESS  

Цель: отработать навыки работы с базами данных. 

Оборудование: задать самостоятельно. 

Программное обеспечение: задать самостоятельно. 

Ход работы: 

1.  Откройте базу данных «Фирма», созданную ранее. 

2.  Выполните команду: вкладка ленты Создание → Мастер запросов → 

Простой запрос. 

3.  В появившемся диалоговом окне укажите таблицу Сотрудники и 

выберите поля Фамилия, Имя, Телефон. Нажмите кнопку Далее. 

4.  Введите имя  запроса – Телефоны – и нажмите кнопку Готово. Перед 

вами появится запрос, в котором можно просмотреть телефоны сотрудников. 

5.  Следующий запрос попробуйте создать с помощью Конструктора, 

для этого выполните команду: вкладка ленты Создание → Конструктор 

запросов. 

6.  В диалоговом окне Добавление таблиц выберите таблицу Клиенты и 

щелкните на кнопке Добавить, а затем – на кнопке Закрыть. 

7.  Чтобы  перенести  нужные  поля  в  бланк  запроса,  необходимо  по  

ним дважды щелкнуть левой кнопкой мыши. 

8.  Чтобы отсортировать записи в поле Название компании в алфавитном 

порядке,  необходимо  в  раскрывающемся  списке  строки  Сортировка  

выбрать пункт по возрастанию. 

9.  Сохраните запрос с именем «Адреса клиентов». 

10. Самостоятельно  создайте  запрос  «Дни  рождения»,  в  котором 

можно будет просмотреть дни рождения сотрудников. 

11. Допустим, мы хотим узнать, у кого из сотрудников день рождения в 

текущем месяце, например в апреле. Для этого откройте запрос в режиме 

Конструктора. 

12. В строке Условие отбора для поля «Дата рождения» введите 

значение *.04.*. В данной  записи * означают, что дата и  год рождения могут 

быть любыми, а месяц 4-м (т. е. апрель) 

13. Закройте Конструктор  и  просмотрите  полученный  результат.  

Если  в запросе Дни рождения нет ни одной записи, значит, в таблице 

Сотрудники нет ни одного человека, родившегося в апреле. Добавьте в 

таблицу Сотрудники несколько человек, родившихся в апреле, и посмотрите, 

как изменится запрос. Запросы автоматически обновляются при каждом 

открытии. 

14. Если нам нужно узнать, кто из сотрудников родился в мае, то 

придется  создать  новый  запрос  или  изменить  условие  в  существующем  

запросе Дни рождения. Данная  процедура  является  неудобной  и  занимает 

много  времени. Если приходится часто выполнять запрос, но каждый раз с 



 

новыми значениями условий используют запрос с параметром. При запуске 

такого запроса на экран выводится диалоговое окно для ввода значения в 

качестве условия отбора. Чтобы создать запрос с параметром, пользователю 

необходимо ввести текст сообщения в строке Условие отбора бланка запроса. 

15. Запись Like[Введите дату] означает, что при открытии  запроса 

появится  диалоговое  окно  с  текстом  «Введите  дату»  и  полем  для  ввода 

условия отбора. Если  ввести условие  *.04.*,  то  в  запросе появится  список  

сотрудников, родившихся в апреле. Запустите запрос еще раз и введите 

значение *.05.*, посмотрите, как изменился запрос. 

16. Измените запрос «Телефоны» так, чтобы при его запуске выводилось 

диалоговое окно с сообщением «Введите фамилию». Поскольку в запросе 

нужно вывести конкретную фамилию, в условии отбора слово Like писать не 

надо. 

17. Измените  запрос «Телефоны»  так, чтобы при его  запуске  

запрашивались не только фамилия, но и имя сотрудника. 

18. Самостоятельно создайте запрос «Выполненные заказы», 

содержащий следующие  сведения: фамилия и имя  сотрудника, название  

компании,  с  которой он работает, отметка о выполнении и сумма  заказа. 

Данные  запроса возьмите из нескольких таблиц. 

19. В условии отбора для логического поля Отметка о выполнении 

введите Да, чтобы в запросе отображались только выполненные заказы. 

20. Сделайте так, чтобы столбец Отметка о выполнении не выводился на 

экран. 

21. Создайте запрос Сумма заказа, в котором будут отображаться заказы 

на сумму более 50 000 руб.  

22. Измените  запрос,  чтобы  сумма  заказа  была  от  20 000  до  50 000  

руб. 

Для данных запросов в условии отбора можно использовать операторы 

сравнения >, <, =, >=, <=, <> и логические операторы And, Or, Not и др. 

23. Иногда  в  запросах  требуется  произвести  некоторые  вычисления,  

например  посчитать  подоходный  налог  13 %  для  каждой  сделки.  Для  

этого  откройте запрос Сумма заказа в режиме Конструктора. 

24. В пустом столбце бланка запроса щелкните правой кнопкой мыши на 

ячейке Поле и в появившемся контекстном меню выберите команду 

Построить.  Перед  вами  появится  окно  Построитель  выражений, который 

состоит  из  трех  областей:  поля  выражения,  кнопок  операторов  и  

элементов выражения. Сверху располагается поле выражения, в котором оно 

и создается. Вводимые  в  это поле  элементы  выбираются  в  двух других 

областях окна Построителя. 

25. В левом списке откройте папку Запросы и выделите запрос Сумма 

заказа.  В  среднем  списке  выделите  поле  Сумма  и  нажмите  кнопку  

Вставить. Идентификатор этого поля появится в поле выражения 

Построителя. 

26. Щелкните на кнопке * и введите 0,13. Таким образом, мы посчитаем 

подоходный налог 13 %. 



 

27. Нажмите кнопку ОК, после чего в ячейке свойства Поле появится 

значение «Выражение1: [Сумма]*0,13». 

28. Замените Выражение1 на Налог и закройте Конструктор. 

29. Откройте запрос и посмотрите, что у вас получилось. 

30. Используя Построитель выражений, добавьте в запрос Сумма заказа 

поле Прибыль, в котором будет вычисляться доход от заказа (т. е. сумма 

минус налог). 

31. Создайте запрос Менеджеры, с помощью которого в таблице 

Сотрудники найдите всех менеджеров фирмы. 

32. Покажите работу преподавателю. 

Создание отчетов 

1.     Открыть базу данных «Сотрудники» 

2.     В окне базы данных выполните команду: вкладка ленты Создание → 

панель инструментов Отчеты → Мастер отчетов. 

3.     Выберите из списка таблицу  «Сотрудники». 

4.     В  появившемся  диалоговом  окне  Создание  отчетов  переместите 

все доступные поля в область «выбранные поля». 

5.     В поле сортировка поле «Фамилия» отсортировать по возрастанию. 

6.     Макет отчета выберите в столбец, ориентация альбомная. 

7.     Стиль отчета выберите на ваше усмотрение. 

8.     Имя отчета «Сотрудники». Нажмите кнопку Готово 

С помощью Мастера отчетов создайте отчет Дни рождения. В качестве 

источника данных используйте таблицу Сотрудники. 

9.   Если  требуется напечатать почтовые наклейки, Access 

предоставляет такую возможность. Для этого выделите таблицу Клиенты и 

выполните команду: вкладка ленты Создание → панель инструментов 

Отчеты → Наклейки. 

6.  В  появившемся  диалоговом  окне укажите  размер  наклейки, 

систему единиц, тип наклейки и нажмите кнопку Далее. 

7.  На следующем шаге создания отчета установите шрифт, размер, цвет 

текста и начертание. Нажмите кнопку Далее. 

8.  Выберите  поля,  которые  будут  размещаться  на  наклейке. 

Например, Название компании, Адрес, Телефон. Если на каждой наклейке 

требуется вывести определенный текст, то введите его в прототип наклейки. 

9.  При необходимости измените, название отчета с наклейками и 

нажмите кнопку Готово. 

10.  Покажите работу преподавателю. 
  



 

Практическая работа 

Организация работы в FineReader. Сканирование изображения 
 

Цель: Обучиться сканированию, распознаванию, редактированию 

документов и передаче их во внешнее приложение. Ознакомиться со средой 

программы FineReader. 

Задание. 

1. Ознакомиться с содержимым документа «Программы для 

распознавания текста» (прочитать файл «ПРОГРАММЫ ДЛЯ 

РАСПОЗНАВАНИЯ.doc»). 

2. Распознать документ из пакета «3D Studio MAX 4» с помощью 

программы FineReader. Проверить полученный текст и сохранить результаты 

в MS Word. 

Распознать документы файлов «101.pdf» (с сохранением 

форматирования) и «lec2.pdf» (произвольное форматирование) с помощью 

программы FineReader. Результаты передать в MS Word. 

  



 

Практическая работа 

Работа в FineReader. Распознавание текста. Проверка правописания 

и сохранение результатов работы 

Цель: ознакомление с программой оптического распознавания текстов 

ABBYY Fine reader 6.  

 

Ход работы: 

 

Перед началом работы убедитесь, что Ваш сканер включен и в него 

вложен нужный Вам документ.  

1. Запустите программу ABBYY FineReader  

(Пуск/Программы/ABBYY FineReader 6.0 Sprint).  

2. Нажмите кнопку , чтобы начать сканирование.  

После того, как программа отсканирует документ, Вы сможете увидеть 

его в окне Изображение. 

3. Нажмите кнопку , распознанный текст появится в окне 

Текст. 

4. Чтобы сохранить результаты распознавания, нажмите 

кнопку . 

Выберите формат документа  Microsoft Word, имя файла СКАНЕР. 

5. Выполните редактирование и форматирование полученного 

текстового документа. 

 

Задание №2 «Распознавание уже имеющихся файлов или изображений в 

текстовый документ Word»  

 

Ход работы: 

1. Запустите программу ABBYY FineReader  

(Пуск/Программы/ABBYY FineReader 6.0 Sprint).  

 

2. Для распознавания текста из графического файла  

– нажмите на стрелку справа от кнопки  и в открывшемся 



 

меню выберите пункт Открыть изображение... В открывшемся окне 

выберите нужный файл (папка Красная книга, имя файла совпадает с именем 

животного). 

– или нажмите кнопку  и укажите путь к нужному 

изображению.  

(папка Красная книга, имя файла совпадает с именем животного). 

Вы сможете увидеть открытый файл в окне Изображение. 

 

 

3. Нажмите кнопку  , распознанный текст появится в окне 

Текст.  

4. Чтобы сохранить результаты распознавания, нажмите кнопку  

. 

Мастер сохранения поможет Вам сохранить результаты распознавания в 

удобной для Вас форме. ИМЯ ФАЙЛА СОВПАДАЕТ С ИМЕНЕМ 

ЖИВОТНОГО. 

5. Выполнить редактирование и форматирование полученного 

текстового документа. 

6. Подготовить небольшое сообщение о животном – наиболее 

интересные факты. 

7. Файл своей работы передать по сети через папку обмена рабочего 

стола. 

 

  



 

Практическая работа 

Создание презентаций в MSPOWERPOINT. Вставка, 
форматирование рисунков, фигур, гиперссылок Шаблоны .  
Вставка звука, видео. Настройка анимации и показа  

Цель: Освоить приемы создания и редактирования мультимедийных 

презентаций; научиться добавлять фрагменты текста, выполнять вставку 

рисунков и объектов, настройку их анимации. 

Порядок выполнения работы: 

Задание 1 – На основе лекционного материала создайте презенцию 

«Программное обеспечение». 

1. Запустите программу подготовки презентаций MS PowerPoint. 

2. Используя команду Создать в меню Файл создайте новую 

презентацию. В окне Применить разметку слайда выберите 

макет Титульный слайд. 

3. В области заголовка слайда введите 

название презентации «Программное 

обеспечение» (размер шрифта 44) , а в 

подзаголовок - текст «Сам по себе компьютер 

не обладает знаниями ни в одной области 

своего применения, все эти знания 

сосредоточены в выполняемых на компьютере 

программах» (размер шрифта 24). 

4. С помощью команды Вставка / 

Создать слайд добавьте новый слайд. В 

перечне макетов выберите Заголовок, схема или 

организационная диаграмма. 

5. Введите в качестве заголовка текст 

«Классификация программного обеспечения». Тип 

диаграммы Организационная диаграмма. 

6. С использованием лекционного материала по данной теме составьте 

развернутую схему, которая должна отображать деление программ на 

основные классы по функциональному признаку. 

7. Добавьте новый слайд с разметкой выбрав макет Заголовок, текст и 

графика. В область заголовка введите текст «Системное программное 

обеспечение». В текстовую рамку поместите текст о его назначении. 

Например, «Системное программное обеспечение – это комплекс 

управляющих и обрабатывающих программ, обеспечивающих техническое 

функционирование вычислительной системы, а также процесса обработки 

информации на компьютере и предоставления пользователю различных 

сервисных услуг». 



 

8. Дважды щелкнув по значку Вставка картинки в области графики 

вставьте подходящий рисунок. 

9. Аналогично создайте слайды с текстовой и графической 

информацией о других классах программного обеспечения. 

10. Для оформления презентации воспользуйтесь готовыми шаблонами 

через меню Формат, команды Оформление слайда, а затем выбрав в том же 

меню команду Фон. 

11. Через меню Показ слайдов, команду Настройка 

анимации настройте анимацию каждого объекта на всех слайдах начиная с 

первого. Для этого щелкните по соответствующей области слайда (заголовка, 

текста, графического объекта) и установите необходимый эффект входа, 

выделения, выхода и др. 

12. Продемонстрируйте презентацию с помощью команды Показ 

слайдов / Начать показ. 

Задание 2 – Создайте презентацию «Режимы PowerPoint». 

1. Создайте новую презентацию. 

2. Выберите макет слайда Титульный слайд. В области заголовка 

слайда введите текст «Режимы PowerPoint», в подзаголовке укажите свою 

фамилию, имя, отчество. 

3. Добавьте новый слайд с макетом Заголовок, текст и графика. В поле 

Заголовок слайда введите текст «Оглавление», в поле Текст слайда введите 

перечень учебных вопросов: 

 обычный режим, 

 режим структуры слайдов, 

 режим сортировщика слайдов, 

 режим показа слайдов. 

4. В поле Вставка картинки добавьте графическую копию окна 

PowerPoint. Для этого установите окно РоwerPoint текущим и нажмите 

комбинацию клавиш Alt+PrintScreen. Затем перейдите в область вставки 

картинки и воспользуйтесь командой Вставить. Отредактируйте вставленное 

изображение. 

5. Добавьте новый слайд с макетом Заголовок, текст и графика. В поле 

Заголовок слайда введите «Обычный режим», в поле Текст слайда введите 

«Обычный режим — это основной режим редактирования, который 

используется для записи и разработки презентации». В поле Вставка 

картинки вставьте и отредактируйте графическую копию окна PowerPoint, 

полученную в обычном режиме. 

6. Вставьте новый слайд, выбрав макет Заголовок, текст и графика. В 

качестве заголовка слайда укажите «Режим структуры», в области текста 

слайда введите текст «Левая область обычного режима MS PowerPoint 

содержит вкладки, позволяющие переходить от слайдов, отображаемых в 



 

виде эскизов (вкладка Слайды) к структуре текста слайда (вкладка 

Структура). В этой области хорошо начинать запись содержания - 

фиксировать идеи, планировать их представление и перемещать слайды и 

текст». 

7. Перейдите на вкладку Структура, и сделайте копию экрана. 

Вставьте графическую копию окна PowerPoint, снятую в режиме структуры, 

на текущий слайд и отредактируйте изображение. 

8. Добавьте новый слайд с макетом Заголовок, текст и графика. В поле 

Заголовок слайда введите «Режим сортировщика слайдов», в поле Текст 

слайда введите «Режим сортировщика слайдов - это монопольное 

представление слайдов в форме эскиза. По окончании создания и 

редактирования презентации сортировщик слайдов дает общую картину 

презентации, облегчая изменение порядка слайдов, их добавление или 

удаление, а также просмотр эффектов перехода и анимации». 

9. Переключите PowerPoint в режим сортировщика слайдов, для чего 

щелкните по соответствующей кнопке в левом нижнем углу окна. В поле 

Вставка картинки вставьте и отредактируйте графическую копию окна 

PowerPoint, полученную в режиме сортировщика слайдов. 

10. Вставьте новый слайд, выбрав макет Заголовок, текст и графика. В 

поле Заголовок слайда введите «Режим показа слайдов», в поле Текст слайда 

введите текст «Показ слайдов занимает весь экран компьютера, как при 

реальной презентации. Презентация отображается во весь экран так, как она 

будет представлена аудитории. Можно посмотреть, как будут выглядеть 

рисунки, временные интервалы, фильмы, анимированные элементы и 

эффекты перехода будут выглядеть в реальном виде». 

11. Переключите PowerPoint в режим показа слайдов с помощью 

соответствующей кнопки Показ слайдов в левом нижнем углу окна. Вставьте 

графическую копию окна PowerPoint, снятую в режиме показа слайдов, на 

текущий слайд и отредактируйте изображение. 

12. Оформите презентацию с использованием шаблонов. Настройте 

анимацию объектов всех слайдов и продемонстрируйте презентацию. 

Сохраните файл презентации в папку с номером своей группы. 

  



 

Практическая работа 

Создание компьютерной мультимедийной 

презентации  и видеоролика 

Цель: отработать навыки создания презентаций. 

Оборудование: задать самостоятельно. 

Программное обеспечение: задать самостоятельно. 

Ход работы: 

Задание 1.  

С помощью программы PowerPoint создать презентацию на тему «Моя 

будущая профессия».  

Презентация должна соответствовать правилам создания презентаций, 

обозначенных преподавателем.  

Отчет должен содержать:  

1. Название работы. Ф.И. , группа  

2. Цель работы.  

3. Особенности профессии.  

4. Учебное заведение.  

5. Перспективы будущей профессии.  

6. Почему я выбрал именно эту профессию?  

7. Заключение.  



 

Практическая работа 

Работа в AdobePhotoshop  

Цель: отработать навыки работы с текстом в графическом редакторе. 

Оборудование: задать самостоятельно. 

Программное обеспечение: задать самостоятельно. 

Ход работы: 
Задание 1. Изгиб и текстура 

1.     Создаем новую заготовку (например, 300*240, разрешением 150, RGB с белым 

фоном). 

2.     Пишем COMPUTER DESIGN горизонтальным текстом , искажаем как 

флаг (Текст – Деформировать текст…), настраиваем параметры. 

 

3.     Пишем LIKE I вертикальным текстом , искажаем как 

дугу (Текст – Деформировать текст…), настраиваем параметры. 

 
4.     Объединяем оба текстовых слоя (но не задний план!) (Выделите слои, 

используя Ctrl+щелчок по слою левой клавишей мыши, затем нажмите комбинацию 

клавиш Ctrl+E). 

5.     Открываем fern.jpg. Переносим картинку в нашу заготовку (Ctrl+A (выделить 

всё), Ctrl+C (скопировать), Ctrl+V (вставить)). При необходимости растягиваем картинку, 

чтобы она закрывала все надписи. 

6.     Слой / Создать обтравочную маску. 

 



 

Задание 2. Кровь 

1.     Создаем новую заготовку 400*400, разрешением 150, RGB, с черным 

фоном (Alt+Backspace). 

2.     Используя белый цвет, пишем «blood» шрифтом Times New Roman, Italic 25 

пунктов по центру. 

3.     Растрируем текстовый слой (Текст – Растрировать текстовый слой). 

4.     Сводим слои (Ctrl+E). 

5.     Изображение / Вращение изображения / 90 против часовой 

6.     Фильтр / Стилизация / Ветер, Способ - Ветер, Направление - Слева. Повторить 

этот фильтр еще 3 раза (Ctrl+F). 

 
7.     Разворачиваем холст обратно (Изображение / Вращение изображения / 90 по 

часовой). 

8.     Фильтр / Галерея фильтров … / Эскиз / Линогравюра. Тоновой баланс: 5-

6, Смягчение: 1-3. 

9.     Изображение / Коррекция / Инверсия. 

10. Выделить текст. 

11. Выбрать основной цвет для заливки текста. Залить текст. 

12. Фильтр / Галерея фильтров / Bas Relief. Detail: 12, Smoothness: 5. 

 
Задание 3. Лед 

1.     Создаем новую заготовку 300*200, разрешением 150, черно-белую с белым 

фоном. 

2.     Используя черный цвет, пишем “ice” шрифтом Times New Roman, Bold Italic 

25 пунктов по центру. 

3.     Растрируем текстовый слой. 



 

4.     Фильтр / Шум / Добавить шум, 70%, одноцветный. 

5.     Сводим слои. 

6.     Фильтр / Pixelate / Crystallize, Cell Size = 3 

7.     Изображение / Повернуть холст / 90 против часовой 

8.     Проинвертировать цвета: Изображение / Регулировки / Инвертировать 

9.     Для создания сосулек: Фильтр / Stylize / Wind, Method - Wind, Direction - From 

the left. 

10. Разворачиваем холст обратно 

11. Изображение / Режим / RGB. 

12. Изображение / Регулировки / Тон/Насыщенность. Включить тонирование (190, 

70, +3). 

 
Задание 4. Пламя 

1.     Создаем новую заготовку (например, 300*100, разрешением 150, Черно-белое 

с белым фоном). 

2.     Пишем DESIGNER горизонтальным текстом. 

3.     Фильтр / Смазывание / Смазывание Гаусса 1 пкс. 

4.     Изображение / Повернуть холст / 90 против часовой. 

5.     Свести слои. 

6.     Проинвертировать цвета: Изображение / Регулировки / Инвертировать. 

7.     Для создания языков пламени: Фильтр / Stylize / Wind, Method - Wind, 

Direction - From the left. 

8.     Для большей реалистичности используем Фильтр / Distort / Ripple amount 50, 

size medium). 

9.     Разворачиваем холст обратно. 

10. Изображение / Режим / Индексированные цвета. 

11. Изображение / Режим / Палитра Black Body 

 
Задание 5. Лава 

1.     Создайте новый документ 600x600 с черным фоном (Alt+Backspace). 

Напишите крупный белый текст, продублируйте текстовый слой (Слои – Создать 

дубликат слоя …). Видимость копии отключите, объедините текстовый слой с фоном 

(Слои – Объединить слои, Ctrl+E). 



 

 
2.     Filter > Stylize > Wind (Method: Wind, Direction: From the 

left). Повторите несколько раз (CTRL+F). 

Filter > Stylize > Wind (Method: Wind, Direction: From the right). Повторите несколько раз 

(CTRL+F). 

 
3.     Установите цвета по умолчанию (D). Затем Filter->Render->Difference 

Clouds. Включите видимость верхнего слоя и установите его прозрачность на 60%. 

Сведите слои. 

 
4.     Filter > Stylize > Extrude 



 

 
5.     Image > Adjustment > Invert 

 
6.     Filter > Sharpen > Unsharp Mask (Amount 500%, Radius: 2, Threshold: 0). Затем 

Filter > Sharpen > Sharpen. Повторить пару раз. 

 
7.     Image > Adjustments > Color Balance: 

- Midtones: [ +100 ] [ 0 ] [ -40 ] 

- Shadows: [ +70 ] [ 0 ] [ -70 ] 

- Highligts: [ +80 ] [ 0 ] [ -40 ] 



 

 
Задание 6. Скалистый текст 

1.     Создайте новый документ 800x300. Установите цвета по умолчанию (D). 

Примените Filter > Render > Clouds 

 
2.     Напишите крупный текст, выделите его щелчком на слое с нажатым Ctrl и 

растушуйте (Select > Feather). Сам текстовый слой можно удалить 

 
3.     Установите цвет переднего плана белым, а заднего плана - серым. Примените 

Filter > Render > Clouds. Сведите слои 

 
4.     Поверните холст: Image > Rotate Canvas > 90CW. Затем Filter->Stylize->Wind 

(Method: Wind. Direction: From the Right). Нажмите CTRL+F примерно 7 раз для повтора 

фильтра. Теперь ставим холст в прежнее положение: Image > Rotate Canvas > 90CCW 



 

 
5.     Filter > Sharpen > Unsharp Mask (Amount 500%, Radius: 2, Threshold: 0). Затем 

Filter > Sharpen > Sharpen. Повторить пару раз 

 
6.     Подберите цвет 

 
Задание 7. Кремовый текст 

1.     Создайте новый документ 700x500. Установите цвета по умолчанию (D). 

Примените Filter > Render > Clouds 

 
2.     Напишите крупный текст, выделите его щелчком на слое с нажатым Ctrl. Сам 

текстовый слой можно удалить 

 
3.     Растушуйте на 5: Select->Feather. Затем Filter > Render > Difference Clouds. 

Повторите этот фильтр несколько раз (CTRL+F). Снимите выделение (CTRL+D) 



 

 
4.     Filter > Stylize > Glowing Edges. Width: 5, Brightness: 7, Smoothness: 8 

 
5.     Filter > Artistic > Plastic Wrap. Highlight Strength: 10, Detail: 9, Smoothness: 3. 

Повторите этот фильтр несколько раз (CTRL+F) 

 
6.     Подберите цвет: Image > Adjustments > Сolor balance: Shadows: [ +80 ] [ 0 ] [ -25 

], Midtones: [ +80 ] [ 0 ] [ -25 ], Highlights: [ +80 ] [ 0 ] [ - 25 ] 

 
Задание 8. Трехмерный текст 

1.     Создаем новую заготовку (например, 400*300, разрешением 150, черно-белое). 

2.     Заливаем фон черным цветом. 

3.     Используя белый цвет, пишем «3D-Text» шрифтом Garamond, Bold, 15 

пунктов. 

4.     Редактирование / Трансформация / Искривление. Тянем вниз левый нижний 

угол. 

5.     Создаем копию слоя. 

6.     Отключаем слой-копию, объединяем текстовый слой с фоном. 

7.     Фильтр / Смазывание / Смазывание движением. Искажение: –20, Дистанция: 

20. 

8.     Фильтр / Стилизация / Вычисление краев. 

9.     Изображение / Регулировки / Инвертировать 

10. Включаем копию слоя, задаем непрозрачность 70% и совмещаем слой с текстом 

с лицевой стороной трёхмерной надписи. 



 

11. Создаем еще одну копию слоя, задаем непрозрачность 30% и совмещаем слой с 

текстом с задней стороной трёхмерной надписи. 

 
Задание 9. Обведенные буквы 

1.     Создаем новую заготовку (например, 300*100, разрешением 150, RGB с белым 

фоном). 

2.     Пишем DESIGNER горизонтальным текстом. 

3.     Фильтр / Стилизация / Вычисление краев. 

4.     Создать копию слоя. 

5.     Размыть копию: Фильтр / Смазывание / Смазывание Гаусса 2 пкс. 

6.     Копию сдвинуть. 

 
Задание 10. Текст, заполненный линиями 

1.     Создайте новый документ 300x300. Жесткой кистью 3 рх закрасьте линиями 

 
2.     Filter > Artistic > Cutout: Number of Levels - 7, Edge simplicity - 2, Edge Fidelity - 

2 

3.     Сохраните изображение как .psd файл, он будет использован как карта 

смещения для другого файла 

4.     Создайте новый документ, напишите в нем крупный жирный текст 

5.     Filter > Distort > Displace, растрируйте текстовый слой 



 

 
6.     В качестве карты смещения выберите сохраненный .psd файл 

 
Задание 11. Стеклянный текст 

1.     Создайте документ произвольных размеров с белым фоном и черным 

напишите что-нибудь на свое усмотрение 

 
2.     Примените к текстовому слою стиль слоя Drop Shadow со следующими 

настройками: 

 
3.     Примените к текстовому слою стиль слоя Bevel and Emboss со следующими 

настройками: 



 

 
Здесь кликните по изображению контура (Gloss Contour) и вручную сделайте 

график примерно таким: 

 
4.     Примените к текстовому слою стиль слоя Color Overlay со следующими 

настройками: 

 
Вот, что должно получиться: 

 
Задание 12. Прозрачный текст. 

1.     Откройте нужную фотографию 



 

 
2.     Добавьте белый текст 

 
3.     Примените к текстовому слою стили слоя Outer Glow и Inner Glow со 

следующими настройками: 

 

 
4.     Смените режим наложения текстового слоя на Overlay 



 

 
5.     Можно поэкспериментировать с другими настройками 

 
Задание 13. Гравировка. 

1.     Создайте документ произвольных размеров с белым фоном, выделите 

прямоугольную область и залейте ее на новом слое белым. 

2.     Примените к этому слою следующие стили слоя: 

 
  

 
  



 

 
Вот, что должно получиться: 

 
3.     Теперь напишите любой текст подходящим шрифтом цветом #5a5858: 

 
4.     Примените к текстовому слою стиль слоя: 

 
Примерный результат: 

 
Задание 14. Неоновое свечение. 

1.     Создаем новую заготовку 400*100, разрешением 150, RGB, белый фон. 

2.     Используя черный цвет, пишем «adobe». 

3.     Растрируем текстовый слой. 



 

4.     Необходимо добиться белых прожилок в буквах: Фильтр / Artistic / Plastic 

Wrap. Можно повторить фильтр несколько раз. 

5.     Залить фоновый слой черным цветом. 

6.     На слое с надписью Изображение / Регулировки / Кривые 

7.     Изображение / Регулировки / Выборочный цвет. Нейтральный. 

 
Задание 15. Сияющий текст 

1.     Создаем новую заготовку (например, 300*300, разрешением 150, RGB). 

2.     Заливаем фон черным цветом. 

3.     Используя белый цвет, пишем «сияющий текст» шрифтом Arial Black, 20 

пунктов по центру. 

4.     Объединяем слои. 

5.     Фильтр / Смазывание / Смазывание Гаусса 2 пкс. 

6.     Фильтр / Stylize / Solarize. 

7.     Создаем копию текущего слоя 

8.     Применяем к копии: Фильтр / Distort / Polar Coordinates с параметром Polar to 

Rectangular. 

9.     Инвертируем изображение. 

10. Поворачиваем на 90 градусов по часовой стрелке. 

11. Три раза выполняем Фильтр / Stylize / Wind с параметрами Method - Wind, 

Direction - From the Right. 

12. Изображение / Регулировки / Автоуровни. 

13. Инвертируем изображение. 

14. Три раза выполняем Фильтр / Stylize / Wind с прежними параметрами. 

15. Поворачиваем на 90 градусов против часовой стрелки. 

16. Фильтр / Distort / Polar Coordinates с параметром Rectangular to Polar. 

17. Нижний слой перетаскиваем наверх. 

18. Задаем режим смешивания «экран». 

19. Объединяем слои. 

 

  



 

Практическая работа 

Организация поиска документов в СПС «Консультант 
Плюс» 

Цель: отработать навыки работы в СПС. 

Оборудование: задать самостоятельно.  

Программное обеспечение: задать самостоятельно. 

Ход работы: 
1. Запустите программу. 

2. В окне программы выберите команду «Карточка поиска» (рис. 1). 

 
Рис. 1. Открытие окна Карточка поиска 

3. Перед нами окно Карточка поиска документов по реквизитам, в которую 

вносятся реквизиты документа для организации его поиска 

 
Рис. 2. Окно Карточка поиска 

4. Найдите «Положение об осуществлении безналичных расчетов физическими 

лицами», принятое 1 апреля 2003 г. Для этого установите курсор на поле Дата и введите 

дату 01.04.2003 и нажмите кнопку Построить список. 



 

 
Рис. 3. Введение Даты 

5. В поле Название документа наберите: безналичн* и физическ* и расч*. Нажмите 

кнопку Найти, чтобы вернуться в Карточку поиска. Чтобы система нашла все документы, 

в названиях которых встречаются отмеченные вами слова с любыми окончаниями (в 

разных грамматических формах), вместо окончания указывается звездочка *. 

 
Рис. 4. Формирование Названия документа 

6. Найден один документ! Результат поиска получен! Постройте список 

документов, нажав клавишу Построить список документов. 



 

 
Рис. 5. Результат поиска 

7. Посмотрите на полное название найденного документа. Хотя это название не 

было известно точно, вы нашли документ и убедились, что поиск является легким и 

понятным. 

 
Рис. 6. Список документов 

8. Откройте документ, кликнув дважды левой кнопкой мыши на названии 

документа. Сохраните его в программе MS Word, для чего нажмите на пиктограмму, как 

показано на рис. 7. 



 

 
Рис. 7. Сохранение открытого документа в MS Word 

9. При сохранение появится окно Копирование в Word. Нажмите кнопку В новый 

документ. 

10. Документ разместится в программе MS Word и теперь его необходимо 

сохранить под именем Пример. 

Задания для самостоятельного выполнения 

1. Найдите Федеральный закон от 27.07.2006 № 149-ФЗ «Об информации, 

информационных технологиях и о защите информации». Найдите статью, посвященную 

ограниченному доступу к информации, и сохраните её в MS Word. 

2. Найдите Постановление Правительства РФ от 28.02.1996 № 226 «О 

государственном учете и регистрации баз и банков данных». Где первоначально был 

опубликован этот документ? 

3. Организация совершила продажу товара за наличный расчет. В соответствии с 

законодательством она должна была воспользоваться контрольно-кассовой машиной либо 

бланками строгой отчетности. Найдите в Кодексе об административных правонарушениях 

РФ размер штрафа за нарушение данного требования. 

4. Необходимо определить, чему равен минимальный размер оплаты труда 

(МРОТ). Найдите последний документ, который внес эти изменения. 

5. Сформируйте список документов по нормам возмещения командировочных 

расходов сотрудников и сохраните все документы в папку «Нормы расходов». 

  



 

Практическая работа 

Организация поиска документов в СПС «Гарант»  

Цель: сформировать навыки работы с СПС. 

Оборудование: задать самостоятельно. 

Программное обеспечение: задать самостоятельно. 

Ход работы:  

1. Откройте сайт http://www.garant.ru, выберите интернет-версию 

ГАРАНТ.  

2. Изучите краткие теоретические сведения. 

3. Перейдите по ссылке «Помощь в работе, возможности системы.  

4. Откройте страницу Информационно-обучающий видеокурс по 

работе с интернет-версией системы ГАРАНТ  http://learning.garant.ru/internet/  

5. Изучить возможности СПС «Гарант» с помощью видеокурсов, все 

кроме ГАРАНТ-LegalTech. Будущее начинается сегодня!  

6. Пройти итоговый тест. Продемонстрировать результат выполненного 

теста преподавателю  

7. Найти нормативно-правовые документы из задания для 

самостоятельной работы, используя возможности СПС «Гарант». Составить 

краткий электронный конспект  

8. Оформить отчет по лабораторной работе 

Задания для самостоятельной работы  

Можно воспользоваться версией для студента _ 

http://study.garant.ru/#/startpage:0 Составить электронный конспект по 

основным правовым актам в области информационной безопасности:  

• ст. ст. 23, 24, 29, 42 Конституции РФ, ст. ст. 5,7,8,9 ФЗ "Об 

информации, информационных технологиях и о защите информации" от 

27.07.2006 N 149-ФЗ (действующая редакция, 2016); 

 • ст.ст. 3, 4 Закона РФ от 27.12.1991 N 2124-1 (ред. от 03.07.2016) "О 

средствах массовой информации" (с изм. и доп., вступ. в силу с 15.07.2016),  

• ст. ст. 7, 8, 9, 11 ФЗ "О персональных данных" от 27.07.2006 N 152- 

ФЗ (действующая редакция, 2016); 18  

• сфера действия и принцип отнесения к гостайне ФЗ РФ от 21.07.1993 

N 5485-1 (ред. от 08.03.2015) "О государственной тайне"; 

 • ст. 2 ФЗ "Об электронной подписи" от 06.04.2011 N 63-ФЗ 

(действующая редакция, 2016);  

• ст.272, 273, 274 УК РФ.  
  



 

 

Практическая работа 

Поисковые системы. Поиск информации на государственных 
информационных порталах. Электронное правительство 

Цель: научиться осуществлять поиск информации с помощью поисковых 

систем. 

Оборудование: ПК на базе процессора (задать самостоятельно). 

Программное обеспечение: задать самостоятельно. 

Ход работы: 
Поисковые системы 
Для поиска интересующей вас информации необходимо указать браузеру адрес 

Web-страницы, на которой она находится. Это самый быстрый и надежный вид поиска. 

Для быстрого доступа к ресурсу достаточно запустить браузер и набрать адрес страницы в 

строке адреса. 

 
Адреса Web-страниц приводятся в специальных справочниках, печатных изданиях, 

звучат в эфире популярных радиостанций и с экранов телевизора. 

Если вы не знаете адреса, то для поиска информации в сети Интернет 

существуют поисковые системы, которые содержат информацию о ресурсах Интернета. 

Каждая поисковая система – это большая база ключевых слов, связанных с Web-

страницами, на которых они встретились. Для поиска адреса сервера с интересующей вас 

информацией надо ввести в поле поисковой системы ключевое слово, несколько слов или 

фразу. Тем самым вы посылаете поисковой системе запрос. Результаты поиска выдаются в 

виде списка адресов Web-страниц, на которых встретились эти слова. 

Как правило, поисковые системы состоят из трех частей: робота, индекса и 

программы обработки запроса. 
Робот (Spider, Robot или Bot) - это программа, которая посещает веб-страницы и 

считывает (полностью или частично) их содержимое. 

Роботы поисковых систем различаются индивидуальной схемой анализа 

содержимого веб-страницы. 

Индекс - это хранилище данных, в котором сосредоточены копии всех посещенных 

роботами страниц. 

Индексы в каждой поисковой системе различаются по объему и способу 

организации хранимой информации. Базы данных ведущих поисковых машин хранят 

сведения о десятках миллионов документов, а объемы их индекса составляют сотни 

гигабайт. Индексы периодически обновляются и дополняются, поэтому результаты 

работы одной поисковой машины с одним и тем же запросом могут различаться, если 

поиск производился в разное время. 

Программа обработки запроса - это программа, которая в соответствии с 

запросом пользователя «просматривает» индекс на предмет наличия нужной информации 

и возвращает ссылки на найденные документы. 

Множество ссылок на выходе системы распределяется программой в порядке 

убывания от наибольшей степени соответствия ссылки запросу к наименьшей. 

В России наиболее распространенными поисковыми системами являются: 

 Рамблер (www.rambler.ru); 

 Яндекс (www.yandex.ru); 

 Мэйл (www.mail.ru). 

За рубежом поисковых систем гораздо больше. Самыми популярными являются: 

 Alta Vista (www.altavista.com); 

 Fast Search (www.alltheweb.com); 



 

 Northern Light (www.northernlight.com). 

Яндекс является пожалуй наилучшей поисковой системой в российском Интернете. 

Эта база данных содержит около 200 000 серверов и до 30 миллионов документов, 

которые система просматривает в течение нескольких секунд. На примере этой системы 

покажем как осуществляется поиск информации. 

Поиск информации задается введением ключевого слова в специальную рамку и 

нажатием кнопки «Найти», справа от рамки. 

 
Результаты поиска появляются в течение нескольких секунд, причем 

ранжированные по значимости – наиболее важные документы размещаются в начале 

списка. При этом ранг найденного документа определяется тем, в каком месте документа 

находится ключевое слово (в заглавии документа важнее, чем в любом другом месте) и 

числом упоминаний ключевого слова (чем больше упоминаний, тем ранг выше). 

 
Таким образом, сайты, расположенные на первых местах в списке, являются 

ведущими не с содержательной точки зрения, а практически, по отношению к частоте 

упоминания ключевого слова. В связи с этим, не следует ограничиваться просмотром 

первого десятка предложенных поисковой системой сайтов. 

Содержательную часть сайта можно косвенно оценить по краткому его описанию, 

размещаемому Поисковой системой под адресом Сайта. Некоторые недобросовестные 

авторы сайтов, для того, чтобы повысить вероятность появления своей Web-страницы на 

первых местах Поисковой системы, умышленно включают в документ бессмысленные 

повторы ключевого слова. Но как только поисковая система обнаруживает такой 

«замусоренный» документ, она автоматически исключает его из своей базы данных. 

Даже ранжированный список документов, предлагаемый поисковой системой в 

ответ на ключевую фразу или слово, может оказаться практически необозримым. В связи 

с этим в Яндекс (как и других мощных Поисковых Машинах) предоставлена возможность 

в рамках первого списка, выбрать документы, которые точнее отражают цель поиска, то 

есть уточнить или улучшить результаты поиска. Например, на ключевое слово список из 

34 899 Веб-страниц. После ввода в команду «Искать в найденном» уточняющего 

ключевого слова список сокращается до 750 страниц, а после ввода в эту команду еще 

одного уточняющего слова этот список сокращается до 130 Веб-страниц. 

 



 

Поиск по рубрикатору поисковой системы 

    Поисковые каталоги представляют собой систематизированную коллекцию 

(подборку) ссылок на другие ресурсы Интернета. Ссылки организованы в 

виде тематического рубрикатора, npeдставляющего собой иерархическую структуру, 

перемещаясь по которой, можно найти нужную информацию. 

    Приведем в качестве примера структуру поискового интернет-каталога Яндекс. 

 
Это каталог общего назначения, так как в нем представлены ссылки на ресурсы 

Интернета практически по всем возможным направлениям. В этом каталоге выделены 

следующие темы: 

 Бизнес и экономика; 

 Общество и политика; 

 Наука и образование; 

 Компьютеры и связь; 

 Справочники и ссылки; 

 Дом и семья; 

 Развлечения и отдых; 

 Культура и искусство. 
Каждая тема включает множество подразделов, а они, в свою очередь, 

содержат рубрики и т. д. 

Предположим, вы готовите мероприятие ко Дню победы и хотите найти в 

Интернете слова известной военной песни Булата Окуджавы «Вы слышите, грохочут 

сапоги». Поиск можно организовать следующим образом: 

Яндекс Каталог Культура и искусство Музыка Авторская песня 
Такой способ поиска является достаточно быстрым и эффективным. В конце вам 

предлагается всего несколько ссылок, среди которых есть ссылки на сайты с песнями 

известных бардов. Остается только найти на сайте архив с текстами песен Б. Окуджавы и 

выбрать в нем нужный текст. 

Другой пример. Предположим, вы собираетесь приобрести мобильный телефон и 

хотите сравнить характеристики аппаратов разных фирм. Поиск мог бы вестись по 

следующим рубрикам каталога:. 

Яндекс Каталог Компьютеры и связь Мобильная связь Мобильные телефоны 
Получив ограниченное количество ссылок, можно достаточно оперативно их 

просмотреть и выбрать телефон, исследовав характеристики по фирмам и модификациям 

аппаратов. 

Поиск по ключевым словам 
Большинство поисковых машин имеют возможность поиска по ключевым словам. 

Это один из самых распространенных видов поиска. 

Для поиска по ключевым словам необходимо ввести в специальном окне 

слово или несколько слов, которые следует искать, и щелкнуть на кнопке Найти. 



 

 
Поисковая система найдет в своей базе и покажет документы, содержащие эти 

слова. Таких документов может оказаться множество, но много в данном случае не 

обязательно означает хорошо. 

Проведем несколько экспериментов с любой из поисковых систем. Предположим, 

что мы решили завести аквариум и нас интересует любая информация по данной теме. На 

первый взгляд самое простое — это поиск по слову «аквариум». Проверим это, например, 

в поисковой системе Яндекс. Результатом поиска будет огромное количество страниц - 

огромное количество ссылок. Причем, если посмотреть внимательнее, среди них окажутся 

сайты, упоминающие группу Б. Гребенщикова «Аквариум», торговые центры и 

неформальные объединения с таким же названием, и многое другое, не имеющее 

отношения к аквариумным рыбкам. 

Нетрудно догадаться, что такой поиск не может удовлетворить даже 

непритязательного пользователя. Слишком много времени придется потратить на то, 

чтобы отобрать среди всех предложенных документов те, что касаются нужного нам 

предмета, и уж тем более на то, чтобы ознакомиться с их содержимым. 

Можно сразу сделать вывод, что вести поиск по одному слову, как правило, 

нецелесообразно, ведь по одному слову очень сложно определить тему, которой посвящен 

документ, веб-страница или сайт. Исключение составляют редкие слова и термины, 

которые практически никогда не используются вне своей тематической области. 

Имея определенный набор наиболее употребительных терминов в нужной области, 

можно использовать расширенный поиск. На рис. показано окно расширенного поиска в 

поисковой системе Яндекс. В этом режиме возможности языка запросов реализованы в 

виде формы. Подобный сервис, включающий словарные фильтры, предлагается почти 

всеми поисковыми системами. 

 
    Попробуем уточнить условия поиска и введем словосочетание «аквариумные 

рыбки». Количество ссылок уменьшится более чем в 20 раз. Этот результат нас устраивает 

больше, но все равно среди предложенных ссылок могут встретиться, например, русские 

сувенирные наборы спичечных этикеток с изображениями рыбок, и коллекции заставок 



 

для Рабочего стола компьютера, и каталоги аквариумных рыбок с фотографиями, и 

магазины аквариумных аксессуаров. Очевидно, что следует продолжить движение в 

направлении уточнения условий поиска. 

Для того чтобы сделать поиск более продуктивным, во всех поисковых системах 

существует специальный язык формирования запросов со своим синтаксисом. Эти 

языки во многом похожи. Изучить их все достаточно сложно, но любая поисковая машина 

имеет справочную систему, которая позволит вам освоить нужный язык. 

 

Правила формирования запросов в поисковой системе Яндекс 

Приведем несколько простых правил формирования запроса в поисковой системе 

Яндекс. 

Ключевые слова в запросе следует писать строчными (маленькими) буквами. 
Это обеспечит поиск всех ключевых слов, а не только тех, которые начинаются с 

прописной буквы. 

При поиске учитываются все формы слова по правилам русского языка, 

независимо от формы слова в запросе. 
Например, если в запросе было указано слово «знаю», то условию поиска будут 

удовлетворять и слова «знаем», «знаете» и т. п. 

Для поиска устойчивого словосочетания следует заключить слова в кавычки. 

Например, «фарфоровая посуда». 

Для поиска по точной словоформе перед словом надо поставить 

восклицательный знак. 
Например, для поиска слова «сентябрь» в родительном падеже следует написать 

«!сентября». 

Для поиска внутри одного предложения слова в запросе разделяют пробелом 

или знаком & 
Например, «приключенческий роман» или «приключенческий&роман». Несколько 

набранных в запросе слов, разделенных пробелами, означают, что все они должны 

входить в одно предложение искомого документа. 

Если вы хотите, чтобы были отобраны только те документы, в которых 

встретилось каждое слово, указанное в запросе, поставьте перед каждым из них знак 

плюс «+». Если вы, наоборот, хотите исключить какие-либо слова из результата 

поиска, поставьте перед этим словом минус «-». Знаки « + » и «-» надо писать через 

пробел от предыдущего и слитно со следующим словом. 
Например, по запросу «Волга -автомобиль» будут найдены документы, в которых 

есть слово «Волга» и нет слова «автомобиль». 

При поиске синонимов или близких по значению слов между словами можно 

поставить вертикальную черту «|». 
Например, по запросу «ребенок | малыш | младенец» будут найдены документы с 

любым из этих слов. 

Вместо одного слова в запросе можно подставить целое выражение. Для этого 

его надо взять в скобки 
Например, «(ребенок | малыш | дети | младенец) +(уход | воспитание)». 

Знак «~» (тильда) позволяет найти документы с предложением, содержащим 

первое слово, но не содержащим второе. 

Например, по запросу «книги ~ магазин» будут найдены все документы, 

содержащие слово «книги», рядом с которым (в пределах предложения) нет слова 

«магазин». 

Если оператор повторяется один раз (например, & или ~), поиск производится 

в пределах предложения. Двойной оператор (&&,~~ ) задает поиск в пределах 

документа. 



 

Например, по запросу «рак ~~ астрология» будут найдены документы со словом 

«рак», не относящиеся к астрологии. 

Вернемся к примеру с аквариумными рыбками. После про¬чтения нескольких 

предлагаемых поисковой системой документов становится понятно, что поиск 

информации в Интернете следует начинать не с выбора аквариумных рыбок. Аквариум - 

сложная биологическая система, создание и поддержание которой требует специальных 

знаний, времени и серьезных капиталовложений. 

На основании полученной информации человек, производящий поиск в Интернете, 

может кардинально изменить стратегию дальнейшего поиска, приняв решение изучить 

специальную литературу, относящуюся к исследуемому вопросу. 

Для поиска литературы или полнотекстовых документов возможен следующий 

запрос: 

«+(аквариум | аквариумист | аквариумистика) +начинающим +(советы | литература) 

+(статья | тезис | полнотекстовый) -(цена | магазин | доставка | каталог)». 

После обработки запроса поисковой машиной результат оказался весьма 

успешным. Уже первые ссылки приводят к искомым документам. 

Теперь можно подытожить результаты поиска, сделать определенные выводы и 

принять решение о возможных действиях: 

Прекратить дальнейший поиск, так как в силу различных причин содержание 

аквариума вам не под силу. 

Прочитать предлагаемые статьи и приступить к устройству аквариума. 

Поискать материалы о хомячках или волнистых попугайчиках. 

 

Задание 1. 
Ответьте на вопросы. 

1. Какой вид поиска является самым быстрым и надежным? 

2. Где пользователь может найти адреса Web-страниц? 

3. Каково основное назначение поисковой системы? 

4. Из каких частей состоит поисковая система? 

5. Какие поисковые системы вы знаете? 

6. Какова технология поиска по рубрикатору поисковой системы? 

7. Какова технология поиска по ключевым словам? 

8. Когда в критерии поиска надо задавать + или -? 

9. Какие критерии поиска в Яндексе заданы следующей фразой: 

10. (няня|воспитатель|гувернантка)++(уход|воспитание|присмотр)? 

11. Что означает удвоение знака (~~ или ++) при формировании сложного 

запроса? 

 

Задание 2. 

1. Загрузите Интернет. 

2. С помощью строки поиска найдите каталог ссылок на государственные 

образовательные порталы. 

3. Выпишите электронные адреса шести государственных образовательных 

порталов и дайте им краткую характеристику. Оформите в виде таблицы. 

  



 

Практическая работа 

Организация коллективной работы в сети Интернет. 
Электронная почта, чат, видео-конференции, дистант, 
тестирование 

Цель работы: научиться применять навыки работы в коллективных 

сервисах сети. 

Оборудование: ПК на базе процессора (задать самостоятельно). 

Программное обеспечение: задать самостоятельно. 

Ход работы: 

Краткие теоретические сведения. 

 Форум – это тематическое общение. В отличие от чата, на форуме обсуждают 

какую-то определенную тему. Можно сказать, что форум – это клуб по интересам. То есть 

форум – это такое место в Интернете, где собираются люди, которых объединяет одно 

увлечение или идея, и общаются на интересующую их тему. Они помогают друг другу 

советами и подсказками, обмениваются жизненным опытом, поддерживают друг друга. 

Для того чтобы найти форум на интересующую тему, можно воспользоваться 

поисковой системой. Например, открыть сайт yandex.ru и напечатать в оранжевой строке 

поиска «форум интересующая тема». Например, «форум кошки». 

Для общения в системе мгновенных сообщений ICQ каждому пользователю 

необходимо иметь специальный идентификационный номер, называемый ICQ UIN. 

ICQ – служба передачи мгновенных сообщений в Интернете. 

Регистрация в системе ICQ 

1.             Перейдите на страницу http://www.icq.com/join/ru 

2.             Перейдя на страницу регистрации ICQ, вы увидите стандартные поля, 

которые вы должны будете заполнить и после нажать кнопку Регистрация. Для успешной 

регистрации заполнять придётся все поля. Рекомендуем обращать внимание на 

всплывающие подсказки справа - они достаточно полезны при возникновении трудностей. 

o          имя, Фамилия - до 20 символов в каждое поле; 

o          адрес электронной почты может быть использован для входа в систему или 

восстановления забытого пароля; 

o          Пароль - у большинства при регистрации возникают проблемы с его 

выбором. Происходит это из-за того, что сервис ICQ установил некие рамки для 

вводимого пароля - он не может быть короче 6 и длиннее 8 символов включительно. Он 

может состоять из заглавных и строчных латинских букв и цифр; 

o          Дата рождения - эта информация необходима для большей безопасности 

вашего ICQ UIN, она будет доступна только вашим друзьям(изменить это правило можно 

в настройках приватности ICQ); 

o          Пол; 

o          Защита от роботов - 5-6 цифр, обычно раза с 2-3 получается распознать их. 

o          Заполнив все поля, нажмите кнопку Регистрация. 

3.             Если все поля были заполнены верно, вы увидите страницу, на которой 

написано, что для завершения процесса регистрации номера аськи нужно нажать на 

ссылку в письме и чуть ниже кнопку для перехода в свой почтовый ящик - жмите её. 



 

4.             В своей почте во Входящих должно появиться новое письмо от ICQ 

Support, откройте его и нажмите ссылку в этом письме. Обычно оно приходит в течение 

10 минут. Если письмо так и нет во Входящих, поищите его во вкладке Спам. 

5.             Итак, вы перешли по ссылке, подтвердив тем самым регистрацию и 

теперь видите страницу, на которой вас информируют о том, что вы успешно 

зарегистрировались в ICQ. 

6.             Для того, чтобы узнать какой номер UIN вами зарегистрирован, нужно 

нажать Скачать в верхнем меню сайта и на открывшейся странице в правом верхнем углу 

вы увидите свою фамилию и имя. Кликнув по этой надписи и вы увидите какой ICQ 

номер вы только что зарегистрировали. 

7.             После успешной регистрации, чтобы пользоваться новым ICQ номером, 

вам необходимо скачать бесплатную версию ICQ. 

  

Skype – программное обеспечение с закрытым кодом, обеспечивающее 

шифрованную голосовую связь и видеосвязь через Интернет между компьютерами а 

также платные услуги для звонков на мобильные и стационарные телефоны. 

Программа также позволяет совершать конференц-звонки (до 25 голосовых 

абонентов, включая инициатора), видеозвонки (в том числе видеоконференции до 10 

абонентов), а также обеспечивает передачу текстовых сообщений (чат) и передачу файлов. 

Есть возможность вместо изображения с веб-камеры передавать изображение с экрана 

монитора 

Регистрация в скайп: 

1.             Для начала вам необходимо скачать программу Скайп. После того как 

программа загрузилась, нажмите на файл установки «SkypeSetup». 

2.             Далее после распаковки должно открыться окно, в котором надо выбрать 

русский язык и нажать на кнопку «Я согласен - установить». 

3.             Дожидаемся конца установки. 

4.             В открывшимся окне, предварительно проверив соединение с интернетом, 

нажмите на надпись «У вас нет логина?». 

5.             Далее появится окно, в котором и произойдет регистрация Скайп. Вам 

необходимо заполнить все поля (Имя, пароль, электронная почта, а также надо будет 

придумать уникальный логин) и нажать  

на кнопку «Я согласен (-на). Создать учетную запись». 

6.             В появившимся окне вводим свой логин и пароль, который указали при 

регистрации. 

Настройка Скайпа - основные настройки Скайпа включают в себя настройку аудио 

параметров (микрофон и наушники) и видео (веб-камера). Обычно пользователям 

самостоятельно не приходиться в ручную настраивать Скайп, все необходимые настройки 

происходят автоматически. Но, не стандартный, старый и слабый микрофон или 

наушники могут потребовать вашего вмешательства. 

Для начала попробуйте тестовый звонок, он совершенно бесплатен. Вам 

предложать прослушать сообщение что бы оценить качества звука через наушники или 

колонки, после этого Вам предложат оставить свое голосовое сообщение, которое Вы же 

потом и прослушаете. Это позволяет оценить качество работы вашего микрофона и 

качество передачи звука через интернет. 



 

Если есть проблемы с качеством звука или качеством интернет соединения, то 

обычно Скайп сам вам об этом сообщит после тестового звонка и предложит пути 

решения проблемы. 

Если все ж вас не устроило качество, то имеет смысл попытаться отключить 

автоматическую настройку микрофона и в ручную установить уровень звука 

Настройка камеры в Скайпе 

Если камера уже работала до Скайпа, то проблем обычно не возникает, Скайп сам 

корректно найдет и настроит веб-камеру. Если веб-камера подключается в первые, то 

следует подключить камеру, а после установить драйвера с диска который шел с камерой. 

 Задание 

 Задание 1. Найти с помощью одной из поисковых систем Интернета форумы по 

следующим темам: 

·                   Компьютеры 

·                   Информатика 

·                   Информационные технологии в строительстве 

·                   Информационные технологии для механиков и т.п. 

Зарегистрироваться на форуме. Предложить на форуме обсуждение интересующего 

вас вопроса по теме форума. Сохранить скрин окна форума в текстовом документе под 

именем ПР25.doc. 

 Задание 2. Зарегистрироваться в системе ICQ, настроить систему, найти в системе 

троих одногруппников, передать им текстовые сообщения. 

 Задание 3. Зарегистрироваться в системе Scype, настроить систему, найти в 

системе трех одногруппников. Добавить их свои Контакты. Осуществить видео-звонок 

одному из них. Выполнить видео-сессию с тремя одногруппниками одновременно. 

 Содержание отчета 

Отчет должен содержать: 

1.                    Название работы. 

2.                    Цель работы. 

3.                    Описание порядка регистрации на форумах, в ISQ, в scype. 

4.                    Вывод по работе. 

  



 

Практическая работа 

Защита информации, антивирусная защита. 
Эксплуатационные требования к компьютерному рабочему месту. 
Профилактические мероприятия для компьютерного рабочего 
места в соответствии с его комплектацией для профессиональной 
деятельности 

Цель: выработать практические навыки работы с антивирусными 

программами, навыки правильной работы с компьютером. 

Оборудование: ПК на базе процессора (задать самостоятельно). 

Программное обеспечение: задать самостоятельно. 

Ход работы: 
Краткие теоретические сведения. 

Вирусы. Антивирусное программное обеспечение 

Компьютерный вирус - программа способная самопроизвольно внедряться и 

внедрять свои копии в другие программы, файлы, системные области компьютера и в 

вычислительные сети, с целью создания всевозможных помех работе на компьютере. 

Признаки заражения: 

 прекращение работы или неправильная работа ранее функционировавших 

программ 

 медленная работа компьютера 

 невозможность загрузки ОС 

 исчезновение файлов и каталогов или искажение их содержимого 

 изменение размеров файлов и их времени модификации 

 уменьшение размера оперативной памяти 

 непредусмотренные сообщения, изображения и звуковые сигналы 

 частые сбои и зависания компьютера и др. 

  

Классификация компьютерных вирусов 

По среде обитания: 

 Сетевые – распространяются по различным компьютерным сетям 

 Файловые – внедряются в исполняемые модули (COM, EXE) 

 Загрузочные – внедряются в загрузочные сектора диска или сектора, 

содержащие программу загрузки диска 

 Файлово-загрузочные – внедряются и в загрузочные сектора и в исполняемые 

модули 

  

По способу заражения: 

 Резидентные – при заражении оставляет в оперативной памяти компьютера 

свою резидентную часть, которая потом перехватывает обращения ОС к объектам 

заражения 

 Нерезидентные – не заражают оперативную память и активны ограниченное 

время 

  

По воздействию: 



 

 Неопасные – не мешают работе компьютера, но уменьшают объем свободной 

оперативной памяти и памяти на дисках 

 Опасные – приводят к различным нарушениям в работе компьютера 

 Очень опасные – могут приводить к потере программ, данных, стиранию 

информации в системных областях дисков 

  

По особенностям алгоритма: 

 Паразиты – изменяют содержимое файлов и секторов, легко обнаруживаются 

 Черви – вычисляют адреса сетевых компьютеров и отправляют по ним свои 

копии 

 Стелсы – перехватывают обращение ОС к пораженным файлам и секторам и 

подставляют вместо них чистые области 

 Мутанты – содержат алгоритм шифровки-дешифровки, ни одна из копий не 

похожа на другую 

 Трояны – не способны к самораспространению, но маскируясь под полезную, 

разрушают загрузочный сектор и файловую систему 

  

Основные меры по защите от вирусов 

 оснастите свой компьютер одной из современных антивирусных программ: 

Doctor Weber, Norton Antivirus, AVP 

 постоянно обновляйте антивирусные базы 

 делайте архивные копии ценной для Вас информации (гибкие диски, CD) 

  

Классификация антивирусного программного обеспечения 

 Сканеры (детекторы). Принцип работы антивирусных сканеров основан на 

проверке файлов, секторов и системной памяти и поиске в них известных и новых 

(неизвестных сканеру) вирусов. 

 Мониторы. Это целый класс антивирусов, которые постоянно находятся в 

оперативной памяти компьютера и отслеживают все подозрительные действия, 

выполняемые другими программами. С помощью монитора можно остановить 

распостранение вируса на самой ранней стадии. 

 Ревизоры. Программы-ревизоры первоначально запоминают в специальных 

файлах образы главной загрузочной записи, загрузочных секторов логических дисков, 

информацию о структуре каталогов, иногда - объем установленной оперативной памяти. 

Программы-ревизоры первоначально запоминают в специальных файлах образы главной 

загрузочной записи, загрузочных секторов логических дисков, информацию о структуре 

каталогов, иногда - объем установленной оперативной памяти. Для определения наличия 

вируса в системе программы-ревизоры проверяют созданные ими образы и производят 

сравнение с текущим состоянием. 

Профилактические мероприятия для компьютерного рабочего места 

1. Требования к микроклимату, ионному составу и концентрации вредных 

химических веществ в воздухе помещений 

На рабочих местах пользователей персональных компьютеров должны 

обеспечиваться оптимальные параметры микроклимата в соответствии с СанПин 

2.2.4.548-96. Согласно этому документу для категории тяжести работ 1а температура 

воздуха должна быть в холодный период года не более 22-24оС, в теплый период года 20-



 

25оС. Относительная влажность должна составлять 40-60%, скорость движения воздуха - 

0,1 м/с. Для поддержания оптимальных значений микроклимата используется система 

отопления и кондиционирования воздуха. Для повышения влажности воздуха в 

помещении следует применять увлажнители воздуха или емкости с питьевой водой. 

2. Требования к освещению помещений и рабочих мест 

В компьютерных залах должно быть естественное и искусственное освещение. 

Световой поток из оконного проема должен падать на рабочее место оператора с левой 

стороны. 

Искусственное освещение в помещениях эксплуатации компьютеров должно 

осуществляться системой общего равномерного освещения. 

Допускается установка светильников местного освещения для подсветки 

документов. Местное освещение не должно создавать бликов на поверхности экрана. 

Отраженная блескость на рабочих поверхностях ограничивается за счет 

правильного выбора светильника и расположения рабочих мест по отношению к 

естественному источнику света. 

Для искусственного освещения помещений с персональными компьютерами 

следует применять светильники типа ЛПО36 с зеркализованными решетками, 

укомплектованные высокочастотными пускорегулирующими аппаратами. Допускается 

применять светильники прямого света, преимущественно отраженного света типа ЛПО13, 

ЛПО5, ЛСО4, ЛПО34, ЛПО31 с люминесцентными лампами типа ЛБ. Допускается 

применение светильников местного освещения с лампами накаливания. Светильники 

должны располагаться в виде сплошных или прерывистых линий сбоку от рабочих мест 

параллельно линии зрения пользователя при разном расположении компьютеров. 

Для обеспечения нормативных значений освещенности в помещениях следует 

проводить чистку стекол оконных проемов и светильников не реже двух раз в год и 

проводить своевременную замену перегоревших ламп. 

3. Требования к шуму и вибрации в помещениях 

Уровни шума на рабочих местах пользователей персональных компьютеров не 

должны превышать значений, установленных СанПиН 2.2.4/2.1.8.562-96 и составляют не 

более 50 дБА. 

Снизить уровень шума в помещениях можно использованием звукопоглощающих 

материалов с максимальными коэффициентами звукопоглощения в области частот 63-

8000 Гц для отделки стен и потолка помещений. Дополнительный звукопоглощающий 

эффект создают однотонные занавески из плотной ткани, повешенные в складку на 

расстоянии 15-20 см от ограждения. Ширина занавески должна быть в 2 раза больше 

ширины окна. 

4. Требования к организации и оборудованию рабочих мест 

Рабочие места с персональными компьютерами по отношению к световым проемам 

должны располагаться так, чтобы естественный свет падал сбоку, желательно слева. 

Схемы размещения рабочих мест с персональными компьютерами должны 

учитывать расстояния между рабочими столами с мониторами: расстояние между 

боковыми поверхностями мониторов не менее 1,2 м, а расстояние между экраном 

монитора и тыльной частью другого монитора не менее 2,0 м. 

Рабочий стол может быть любой конструкции, отвечающей современным 

требованиям эргономики и позволяющей удобно разместить на рабочей поверхности 

оборудование с учетом его количества, размеров и характера выполняемой работы. 



 

Целесообразно применение столов, имеющих отдельную от основной столешницы 

специальную рабочую поверхность для размещения клавиатуры. Используются рабочие 

столы с регулируемой и нерегулируемой высотой рабочей поверхности. При отсутствии 

регулировки высота стола должна быть в пределах от 680 до 800 мм. 

Глубина рабочей поверхности стола должна составлять 800 мм (допускаемая не 

менее 600 мм), ширина - соответственно 1 600 мм и 1 200 мм. Рабочая поверхность стола 

не должна иметь острых углов и краев, иметь матовую или полуматовую фактору. 

Рабочий стол должен иметь пространство для ног высотой не менее 600 мм, 

шириной - не менее 500 мм, глубиной на уровне колен - не менее 450 мм и на уровне 

вытянутых ног - не менее 650 мм. 

Быстрое и точное считывание информации обеспечивается при расположении 

плоскости экрана ниже уровня глаз пользователя, предпочтительно перпендикулярно к 

нормальной линии взгляда (нормальная линия взгляда 15 градусов вниз от горизонтали). 

Клавиатура должна располагаться на поверхности стола на расстоянии 100-300 мм 

от края, обращенного к пользователю. 

Для удобства считывания информации с документов применяются подвижные 

подставки (пюпитры), размеры которых по длине и ширине соответствуют размерам 

устанавливаемых на них документов. Пюпитр размещается в одной плоскости и на одной 

высоте с экраном. 

Для обеспечения физиологически рациональной рабочей позы, создания условий 

для ее изменения в течение рабочего дня применяются подъемно-поворотные рабочие 

стулья с сиденьем и спинкой, регулируемыми по высоте и углам наклона, а также 

расстоянию спинки от переднего края сидения. 

Конструкция стула должна обеспечивать: 

 ширину и глубину поверхности сиденья не менее 400 мм; 

 поверхность сиденья с закругленным передним краем; 

 регулировку высоты поверхности сиденья в пределах 400-550 мм и углом 

наклона вперед до 15 градусов и назад до 5 градусов; 

 высоту опорной поверхности спинки 300±20 мм, ширину - не менее 380 мм и 

радиус кривизны горизонтальной плоскости 400 мм; 

 угол наклона спинки в вертикальной плоскости в пределах 0±30 градусов; 

 регулировку расстояния спинки от переднего края сидения в пределах 260-400 

мм; 

 стационарные или съемные подлокотники длиной не менее 250 мм и шириной 

50-70 мм; 

 регулировку подлокотников по высоте над сиденьем в пределах 230±30 мм и 

внутреннего расстояния между подлокотниками в пределах 350-500 мм; 

 поверхность сиденья, спинки и подлокотников должна быть полумягкой, с 

нескользящим не электризующимся, воздухонепроницаемым покрытием, легко 

очищаемым от загрязнения. 

Рабочее место должно быть оборудовано подставкой для ног, имеющей ширину не 

менее 300 мм, глубину не менее 400 мм, регулировку по высоте в пределах до 150 мм и по 

углу наклона опорной поверхности подставки до 20 град. Поверхность подставки должна 

быть рифленой и иметь по переднему краю бортик высотой 10 мм. 

5. Режим труда и отдыха при работе с компьютером 



 

Режим труда и отдыха предусматривает соблюдение определенной длительности 

непрерывной работы на ПК и перерывов, регламентированных с учетом 

продолжительности рабочей смены, видов и категории трудовой деятельности. 

Виды трудовой деятельности на ПК разделяются на 3 группы: группа А - работа по 

считыванию информации с экрана с предварительным запросом; группа Б - работа по 

вводу информации; группа В - творческая работа в режиме диалога с ПК. 

Если в течение рабочей смены пользователь выполняет разные виды работ, то его 

деятельность относят к той группе работ, на выполнение которой тратится не менее 50% 

времени рабочей смены. 

Категории тяжести и напряженности работы на ПК определяются уровнем 

нагрузки за рабочую смену: для группы А - по суммарному числу считываемых знаков; 

для группы Б - по суммарному числу считываемых или вводимых знаков; для группы В - 

по суммарному времени непосредственной работы на ПК. В таблице приведены категории 

тяжести и напряженности работ в зависимости от уровня нагрузки за рабочую смену. 

Виды категорий трудовой деятельности с ПК 

Категория работы по 

тяжести и напряженности 

Уровень нагрузки за рабочую смену при 

видах работы на ПК 

Группа А 

Количеств

о знаков 

Группа Б 

Количеств

о знаков 

Группа 

В 

Время 

работы, ч 

I 

II 

III 

До 20000 

До 40000 

До 60000 

До 15000 

До 30000 

До 40000 

До 2,0 

До 4,0 

До 6,0 

Количество и длительность регламентированных перерывов, их распределение в 

течение рабочей смены устанавливается в зависимости от категории работ на ПК и 

продолжительности рабочей смены. 

При 8-часовой рабочей смене и работе на ПК регламентированные перерывы 

следует устанавливать: 

  

 для первой категории работ через 2 часа от начала смены и через 2 часа после 

обеденного перерыва продолжительностью 15 минут каждый; 

 для второй категории работ - через 2 часа от начала рабочей смены и через 1,5-

2,0 часа после обеденного перерыва продолжительностью 15 минут каждый или 

продолжительностью 10 минут через каждый час работы; 

 для третьей категории работ - через 1,5- 2,0 часа от начала рабочей смены и 

через 1,5-2,0 часа после обеденного перерыва продолжительностью 20 минут каждый или 

продолжительностью 15 минут через каждый час работы. 

При 12-часовой рабочей смене регламентированные перерывы должны 

устанавливаться в первые 8 часов работы аналогично перерывам при 8-часовой рабочей 

смене, а в течение последних 4 часов работы, независимо от категории и вида работ, 

каждый час продолжительностью 15 минут. 

Продолжительность непрерывной работы на ПК без регламентированного 

перерыва не должна превышать 2 часа. 



 

При работе на ПК в ночную смену продолжительность регламентированных 

перерывов увеличивается на 60 минут независимо от категории и вида трудовой 

деятельности. 

Эффективными являются нерегламентированные перерывы (микропаузы) 

длительностью 1-3 минуты. 

Регламентированные перерывы и микропаузы целесообразно использовать для 

выполнения комплекса упражнений и гимнастики для глаз, пальцев рук, а также массажа. 

Комплексы упражнений целесообразно менять через 2-3 недели. 

Пользователям ПК, выполняющим работу с высоким уровнем напряженности, 

показана психологическая разгрузка во время регламентированных перерывов и в конце 

рабочего дня в специально оборудованных помещениях (комнатах психологической 

разгрузки). 

6. Медико-профилактические и оздоровительные мероприятия. 

Все профессиональные пользователи ПК должны проходить обязательные 

предварительные медицинские осмотры при поступлении на работу, периодические 

медицинские осмотры с обязательным участием терапевта, невропатолога и окулиста, а 

также проведением общего анализа крови и ЭКГ. 

Не допускаются к работе на ПК женщины со времени установления беременности 

и в период кормления грудью. 

Близорукость, дальнозоркость и другие нарушения рефракции должны быть 

полностью корригированы очками. Для работы должны использоваться очки, 

подобранные с учетом рабочего расстояния от глаз до экрана дисплея. При более 

серьезных нарушениях состояния зрения вопрос о возможности работы на ПК решается 

врачом-офтальмологом. 

Для снятия усталости аккомодационных мышц и их тренировки используются 

компьютерные программы типа Relax. 

Интенсивно работающим целесообразно использовать такие новейшие средства 

профилактики зрения, как очки ЛПО-тренер и офтальмологические тренажеры ДАК и 

«Снайпер-ультра». 

Досуг рекомендуется использовать для пассивного и активного отдыха (занятия на 

тренажерах, плавание, езда на велосипеде, бег, игра в теннис, футбол, лыжи, аэробика, 

прогулки по парку, лесу, экскурсии, прослушивание музыки и т.п.). Дважды в год (весной 

и поздней осенью) рекомендуется проводить курс витаминотерапии в течение месяца. 

Следует отказаться от курения. Категорически должно быть запрещено курение на 

рабочих местах и в помещениях с ПК. 

7. Обеспечение электробезопасности и пожарной безопасности на рабочем месте 

На рабочем месте пользователя размещены дисплей, клавиатура и системный блок. 

При включении дисплея на электронно-лучевой трубке создается высокое напряжение в 

несколько киловольт. Поэтому запрещается прикасаться к тыльной стороне дисплея, 

вытирать пыль с компьютера при его включенном состоянии, работать на компьютере во 

влажной одежде и влажными руками. 

Перед началом работы следует убедиться в отсутствии свешивающихся со стола 

или висящих под столом проводов электропитания, в целостности вилки и провода 

электропитания, в отсутствии видимых повреждений аппаратуры и рабочей мебели. 

Токи статического электричества, наведенные в процессе работы компьютера на 

корпусах монитора, системного блока и клавиатуры, могут приводить к разрядам при 



 

прикосновении к этим элементам. Такие разряды опасности для человека не 

представляют, но могут привести к выходу из строя компьютера. Для снижения величин 

токов статического электричества используются нейтрализаторы, местное и общее 

увлажнение воздуха, использование покрытия полов с антистатической пропиткой. 

Пожарная безопасность - состояние объекта, при котором исключается 

возможность пожара, а в случае его возникновения предотвращается воздействие на 

людей опасных его факторов и обеспечивается защита материальных ценностей. 

Противопожарная защита - это комплекс организационных и технических 

мероприятий, направленных на обеспечение безопасности людей, предотвращение 

пожара, ограничение его распространения, а также на создание условий для успешного 

тушения пожара. 

Пожарная безопасность обеспечивается системой предотвращения пожара и 

системой пожарной защиты. Во всех служебных помещениях обязательно должен быть 

«План эвакуации людей при пожаре», регламентирующий действия персонала в случае 

возникновения очага возгорания и указывающий места расположения пожарной техники. 

Пожары в вычислительных центрах (ВЦ) представляют особую опасность, так как 

сопряжены с большими материальными потерями. Характерная особенность 

ВЦ - небольшие площади помещений. Как известно, пожар может возникнуть при 

взаимодействии горючих веществ, окислителя и источников зажигания. В помещениях 

ВЦ присутствуют все три основные фактора, необходимые для возникновения пожара. 

Горючими компонентами на ВЦ являются: строительные материалы для 

акустической и эстетической отделки помещений, перегородки, двери, полы, изоляция 

кабелей и др. 

Источниками зажигания в ВЦ могут быть электрические схемы от ЭВМ, приборы, 

применяемые для технического обслуживания, устройства электропитания, 

кондиционирования воздуха, где в результате различных нарушений образуются 

перегретые элементы, электрические искры и дуги, способные вызвать загорания горючих 

материалов. 

В современных ЭВМ очень высокая плотность размещения элементов электронных 

схем. В непосредственной близости друг от друга располагаются соединительные 

провода, кабели. При протекании по ним электрического тока выделяется значительное 

количество теплоты. При этом возможно оплавление изоляции. Для отвода избыточной 

теплоты от ЭВМ служат системы вентиляции и кондиционирования воздуха. При 

постоянном действии эти системы представляют собой дополнительную пожарную 

опасность. 

Для большинства помещений ВЦ установлена категория пожарной опасности В. 

Одна из наиболее важных задач пожарной защиты - защита строительных 

помещений от разрушений и обеспечение их достаточной прочности в условиях 

воздействия высоких температур при пожаре. Учитывая высокую стоимость электронного 

оборудования ВЦ, а также категорию его пожарной опасности, здания для ВЦ и части 

здания другого назначения, в которых предусмотрено размещение ЭВМ, должны быть 

первой и второй степени огнестойкости. Для изготовления строительных конструкций 

используются, как правило, кирпич, железобетон, стекло, металл и другие негорючие 

материалы. Применение дерева должно быть ограничено, а в случае использования 

необходимо пропитывать его огнезащитными составами. 

  



 

Задание 

Задание 1. Обновите через Интернет антивирусную программу, установленную на 

Вашем компьютере. Выполните проверку папки «Мои документы» на вирусы. Дать 

характеристику этой программы. 

  

Задание 2. Укажите требования к помещениям кабинета информатики: 

  

Задание 3. Укажите, какие действия запрещены в кабинете информатики. 

  

Задание 4. Укажите комплекс упражнений для снятия усталости за компьютером. 

  

 Контрольные вопросы 

1. Что такое вирус? 

2. Дайте классификацию вирусов. 

3. Для чего нужны антивирусные программы? 

4. Дайте их классификацию 

5. Требования к кабинету информатики. 

6. Комплекс упражнений для снятия усталости за компьютером 
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